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Introduction to ArcGIS 
 
ArcGIS is a scalable system of GIS software 
produced by Environmental Systems Research 
Institute (ESRI).  This system contains three 
different products: ArcView, ArcEditor, and 
ArcInfo.   

 
ArcView 
ArcView is the desktop version meant for a general (non-professional) audience. It 
is the most popular desktop GIS software program, but it is not the only one.  With 
the jump from ArcView 3.2 to ArcView 8.x, ESRI brought ArcView into its ArcMap 
system so that it uses the same structure as its more sophisticated GIS products.  
ArcView 3.x has similar functionality to ArcView 8, but the products work in very 
different ways. ArcView 9 adds some functionality to ArcView 8, but the two 
versions work in a very similar way. 
 
ArcEditor 
ArcEditor includes all the functionality of ArcView, adding the ability to edit features 
in a multiuser geodatabase so that multiuser editing and versioning are possible.  
ArcEditor also adds the ability to edit topologically integrated features in a geodatabase. 
 
ArcInfo 
ArcInfo is ESRI’s professional GIS software.  It includes all of the functionality in 
ArcView and ArcEditor, adding some advanced geoprocessing and data conversion 
capabilities. 
 
ArcSDE is ESRI’s database service, allowing you to manage geographic information 
in several different types of databases (IBM DB2, Informix, Microsoft SQL Server, 
and Oracle) while ArcIMS adds internet map services. 
 

Introduction to ArcView 9 
 
ArcView 9 includes two separate applications: ArcCatalog, 
and ArcMap.  Although they are designed to work together, 
they run under separate executable files (.exe) so they each 
have their own icons. 

 
 
 
ArcCatalog works sort of like Windows Explorer. It is a place to browse and 
manage your data.  You can also create and edit metadata in ArcCatalog. 
 
ArcMap is where you actually create maps.  This is where you will spend most of 
your time. 
 
ArcToolbox was a separate application in ArcView 8. For ArcView 9, it has been 
integrated directly into ArcCatalog and ArcMap.



Cartographic Modeling Laboratory                                                                                          ArcView 9 Manual 
 

 3

Introduction to ArcCatalog 
 
 
ArcCatalog is designed to help you manage 
your spatial and non-spatial data.Using 
ArcCatalog may seem awkward, particularly 
to people who are familiar with ArcView 3.x.  
Using ArcCatalog will help you to develop 
good GIS habits, so it’s worth the effort.    
 
Connecting to Folder 
When you launch ArcCatalog (from the Start menu, go to ArcGIS, then ArcCatalog, 
or add a shortcut to your desktop), a list of all the folders and sub-folders on your 
computer will be displayed on the left in the catalog tree.  “Connect to folder” 
allows you to make a direct connection to the place on your computer where your 
GIS data are stored. This is not necessary but will save time.  You will use these 
same shortcuts in ArcMap (and you can connect to folder from ArcMap, as well). 

From the file menu, go to “Connect Folder…” or click 
on the “Connect To Folder” button (yellow arrow 
against a globe).  Navigate until you find the folder 
with your data and click “OK.”  Your folder should 
now be listed under “Catalog” next to a         icon. 

 
Seeing File Types 
When the contents tab is active in the window on the 
right (catalog display), ArcView will indicate the type of 
file using icons.  Shapefiles, the format for geographic 
files in ArcView, are made up of three or more separate 
files.  If you viewed them outside of ArcCatalog (in 
Windows Explorer or through My Computer), you would 
see all of the files listed with extensions such as .dbf, 
.shp, .shx (see example at right). 
 

In ArcCatalog these various files will appear as a 
single shapefile. ArcCatalog also indicates what kind 
of shapefile: point, line, polygon, or geocoding 
service. In the example on the left, the file 
“hospitals.shp” is made up of points, 
“nis_neighborhoods.shp” is made up of polygons, 
and “phila_rails.shp” is made up of lines.  
“phila_streets.mxs” is a geocoding service. This 
means that it has been indexed so that you can use 
it to geocode addresses.  By copying and pasting 
shapefiles using ArcCatalog, you insure that you will 
keep all of the components of a shapefile together. 

 
Tables that contain no spatial information can also be 
displayed in ArcCatalog.  The icon changes depending upon 
the type of table.  Images can also be displayed. 
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Creating Thumbnails 
For some files, including maps and layers 
created in ArcMap, ArcCatalog will display a 
thumbnail image of your data when the 
“contents” tab is active.   
To create thumbnails for shapefiles and images (you cannot create thumbnails for 
tables), click the “preview” tab, highlight the shapefile name, and click on the 
“Create Thumbnail” button.  Click on the “contents” tab in order to view 
thumbnails. 
 
Previewing Files 
By making the “preview” tab active, you can look more carefully at files.  When the 
preview drop-down menu at the bottom of the window on the right is set to 
“geography,” you can see what your geographic data looks like mapped.  You need 
to view your data in ArcMap in order to make changes to the way it displays, but 
this preview in ArcCatalog allows you to look quickly at your data. You can also 
view images here (ArcCatalog may ask you if you want to build pyramids in order to 
display these more quickly, which is probably a good idea). 
  
Switch the preview drop-down to “table” in 
order to view the attributes associated with 
your geographic features.   
 

Click on the “options” button to add a new 
field or export the table.  Right clicking on a 
column heading allows you to access a 
number of other functions such as sort, 
freeze/unfreeze column, delete field, and 
statistics (the statistics option is only available 
for numeric fields).  You can also access these 
functions in ArcMap. 

 
Checking Properties 
Double click on the file name to bring up the 
shapefile or table properties (or by highlighting the 
file name and choosing “properties” from the File 
menu).  With the fields tab active, you can identify 
the data type for each of the columns in your table.  
When you click on a column name, the length of 
the field will appear below. The column called 
“shape” will appear for your shapefiles.  When you 
click on the field name “shape,” several new field 
properties appear at the bottom.  From the “spatial 
reference” field, you can see what datum and 
projection have been defined (if any).  You can 
change or add to this information by clicking on the 
“…”  From the index tab, you can create attribute 
or spatial indexes in order to increase the speed of 
searching, querying, and drawing data. 
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Updating Metadata 
ArcCatalog also allows you to update and store metadata.  Click on the “metadata” 
tab to access this functionality.  Sometimes you will receive data that contains 
metadata, but generally this is something you will have to add after acquiring or 
building a dataset.  ArcCatalog offers several different stylesheets that define the 
types of information that can be included in the metadata documentation.  The 
default is ESRI’s stylesheet, but you can change this from the stylesheet dropdown 
menu.   
The buttons to the right of this 
dropdown menu allow you to (in 
order) edit metadata, view 
metadata properties, create/ 
update metadata, import, and 
export metadata. 
 

Click on the “edit metadata” button 
in order to add or edit your 
metadata.  You will probably not be 
able to fill in all of the requested 
(“required”) fields, but fill in as much 
as you can.  Most important are a 
description of the data (including the 
date, spatial extent, and geographic 
level), limits on access (who can use 
the data?), contact information 
(when and from whom did you 
acquire the data?), data values (is 
there a data dictionary that explains 
the meaning of values?), and data 
quality (are there known problems?). 

 
Other ArcCatalog Functions 
These are the basic functions in ArcCatalog—organizing and previewing data and 
working with metadata.  ArcCatalog also has extensive search capabilities, making 
it possible to locate files based on name, location on your computer, geographic 
location, and date.  You can geocode addresses and work with maps and layers, 
although these are functions that can also be done through ArcMap. 
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Introduction to ArcMap 
 
 
ArcMap is where you create maps and 
access most of the ArcGIS functionality.  
You can access some of the same functions 
through ArcCatalog and will need to decide 
for yourself which approach you find works 
best for you.    
 
Starting ArcMap 

You can launch ArcMap in several ways.  If you are in ArcCatalog, click on 
the “Launch ArcMap” button.  Alternatively, go to the start menu, ArcGIS, 
and ArcMap or double-click on a desktop icon (if you created one).   

When ArcMap opens, you will be asked if you want to open an empty map, use a 
template, or open an existing map.  You can prevent this dialog from displaying 
again by putting a check mark in the “do not show this dialog again” box. 
 
Customizing the Interface 
ArcMap is made up of many different windows and (dock-able) toolbars that you 
can resize and move around, so don’t be surprised if ArcMap looks slightly different 
each time you open it.   

The window that lists your 
map layers is the table of 
contents; the window that 
shows your map is the 
map display.  You can 
close the table of contents 
by clicking on the “x” and 
resize it by holding your 
cursor over the right edge 
until your cursor changes 
to a two-headed arrow.  
Left-click and drag the 
edge to resize this window.  
To move one of your 
toolbars, left click on the 
end (top or left), hold 
down, and move to a new 
location.   

Adding Tools and Toolbars 
To add or remove a toolbar, left click anywhere outside of the table of contents, 
map display, or toolbar (somewhere gray) or, from the view menu, go to “toolbars.”  
Anything with a check mark next to it will be displayed.   You can also add new 
buttons to your toolbars from the “customize” option.  One especially helpful button 
allows you to zoom continuously.  Choose the commands tab, scroll down to 
“pan/zoom,” then right click on the “Continuous Pan and Zoom” button on the right 
and drag it to your tools toolbar (the toolbar with the outline of a hand and an 
image of a globe in the middle) and release. 
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Working with the Table of Contents 
The table of contents has two tabs (at the bottom): display and source.  When the 
display tab is active, the table of contents will only list data that can be drawn as a 
map layer.  When the source tab is active, the table of contents will also show 
tables along with the path indicating where the data are stored.  Turn on and off a 
layer by checking and unchecking the box next to it.  Layers are drawn in the map 
display in the order in which they are shown in the table of contents.  Map layers 
listed at the top will draw on top.  To move a layer, left click and hold the mouse 
button down, then move the layer. 
 
Navigating a Map 

There are several tools available for zooming in and out of your map.  The 
continuous zoom tool gives you the greatest amount of control.  Click on it, 
then left click on your map, hold down the mouse button, and move your 
mouse away from you to zoom in and toward you to zoom out.  If you right 
click and hold down, this becomes a tool for panning (moving map around 
without changing the extent).  This is not a standard tool, so you will need 
to add it.  See instructions on previous page for customizing toolbar. 
 
Using the other (non-continuous) zoom tools, you can click on your map to 
zoom in or out at a fixed amount or to draw a box around the area that you 
want to see in more or less detail.  The new map will be drawn so that the 
area you drew the box around is in the middle of the map display. 
 
The fixed zoom in/fixed zoom out tools work like the zoom tools when you 
click them rather than draw a box.  Each time you click, you will zoom in or 
out a fixed amount. 
 
The pan tool works like the continuous zoom tool when you right click on it.  
Think of the pan tool as a sticky hand.  Left click on your map display, hold 
the mouse button down, and shift your map.  Your extent (amount zoomed 
in or out) stays the same while your map moves. 
 
The full extent button will zoom in or out so that all of your active 
(checked) map layers can be viewed.  You can also zoom in to a single 
layer by right clicking on the layer in the table of contents and choosing 
“zoom to layer.” 
 
The previous extent buttons allow you to return to the extent you had 
before using one of the zoom tools.  The next extent button allows you to 
jump forward an extent (after you have used the previous extent button). 
 

Identifying Attributes of Features 
The points, lines, and polygons that make up map layers are all map features that 
have attributes stored in a table.  You can access this information in several 
different ways.  Using the identify tool       click on a map feature in the map 
display.  An “identify results” box will display all of the information known about 
that feature.  Notice the layers dropdown menu. The default in ArcMap is to display 
information only about the top-most layer.   
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Showing Map Tips 
Map tips are small text boxes that appear when 
you hold the cursor over a map feature.  You can 
determine which value in your attribute table is 
used in the map tips.  Double click on your 
shapefile name in the table of contents and, from 
the Layer Properties dialogue, make the Display tab 
active.  Put a check mark in the “Display Map Tips” 
box.  To change the primary data field, make the 
Fields tab active and choose a field from the 
“primary display field” dropdown menu. 
 

 
Selecting Features 
You can also use the select features tool to identify 
attributes, either by clicking on a particular map 
feature or by drawing a box around the feature(s) 
of interest.  The selected features should become 
highlighted with a blue outline.  Right click on the 
map layer that contains the feature(s) of interest 
and go to “open attribute table.”  This table 
includes all the attributes of all the features in that 
layer.  In order to view just the selected feature(s), 
click on the “selected” button at the bottom of the 
table.  You can also highlight a feature on the map 
by clicking on a row in the table.  You can change 
the selection color from “options…” in the selection 
menu.  It is also possible to use different colors for 
each layer.  Double click on a map layer, or right 
click and go to “properties.”  Choose the selection 
tab and then select the last radio button, “Show 
selected features with this color.”  This will only 
change the selection color for this map layer. 
 
 
Changing Map Symbols 
ArcMap has many options for changing the way your data are displayed. Some of 
the simplest options involve the choice of color, fill pattern, and shape (for point 
data).  To make changes, click on the map symbol in the table of contents.  The 
symbol selector window that opens will look different depending upon the type of 
layer: point, line, or polygon.  For points, you can choose a different marker from 
the default (which is a circle with a black outline).  When you choose a new marker, 
the default size jumps from 4 point (quite small) to 18 point (quite large).  You can 
find many more symbols by clicking on “more symbols.”  Remove the check mark 
next to one of the categories of symbols if you find that it is not helpful (to reduce 
the amount of scrolling necessary to find appropriate symbols).   
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You can change the color, size, and angle 
using the options on the right of the 
window.  The “reset” button will undo any 
changes you have made to the symbol 
since opening the symbol selector window.  
For lines, the options are similar.  For 
polygons, you have choices about the fill 
pattern, fill color, and outline color.  The 
properties button will give you additional 
options (and often too many options) but 
may be helpful in fine-tuning the 
crosshatch and ordered stipple patterns. 
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Managing & Saving Files  
 
ArcGIS can integrate many different types of data into maps. The most common 
forms are tabular data and geographic data, but you may also use various images.  
Through ArcMap, you can create additional types of files, including map documents 
(.mxd) and map layers (.lyr). Naming and storing these files in a consistent manner 
will make your work with ArcGIS much easier. 
 
Tabular data 
Tabular data includes things like comma-
delimited or fixed width text files, Excel 
worksheets, ACCESS files, and dbase files.  
This is where you store attribute data, such 
as census data. ArcMap can only work with 
comma-delimited text (.txt) and dbase 
(.dbf) files, so frequently you will need to 
convert your tables to one of these formats 
before adding it to ArcMap. 
 
Geographic data 
Geographic data are unique to GIS programs because they allow you to create 
maps by locating them in real world coordinates. Shapefiles are the standard 
format for geographic data in ArcView, but you can also use tables that contain X 
and Y coordinates (for point data) or convert geographic files in other formats into 
shapefiles. Shapefiles are made up of three or more separate files that all need to 
be located in the same directory in order for ArcMap to recognize them as parts of a 
shapefile. (Note: shapefiles are used for vector GIS data. Raster GIS data are 
stored in files that are more similar to images). 
   
Images 
ArcGIS allows you to import and export many different types of images.  The 
images you import may be scanned paper maps, aerial photos, or other pictures or 
photos that you “hot link” to your map features. ArcMap can import a wide range of 
file types. You can also export finished maps in ArcMap in a number of formats: 
EMP, BMP, EPS, TIFF, PDF, JPEG, CGM, JPEG, PCX, and PNG. 
 

Map Documents  
If you save all of your work in ArcMap (by 
going to the file menu, “save” or “save as”), 
you will create a map document (.mxd).  
This file will save all of the work you have 
done, including the data you have added and 
the changes you have made to layer 
properties, symbology, and the layout.  This 
.mxd file does NOT save all of the data you 
included in your map. Instead, it includes 
information about the location of those files 
on your computer (or network, or Internet) 
and the formatting changes you made.   
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This means that you cannot move the data files you’ve included in a map document 
without running into problems.  It also means that map documents are difficult to 
transfer from one computer to another. 
 
If you do move one of the files used in your 
map document, that layer will be shown 
with a ! next to it and will not draw when 
you open your map document.  If you click 
on the grayed out check mark beside the 
layer name, ArcMap will bring up a dialog 
asking where you moved the file.  
Navigating to the file in its new location 
and clicking “add” will solve the problem, 
but this can be time-consuming (and 
frustrating) and is best avoided. 
 
 
 

Using Relative Paths 
One way to minimize problems when 
you move files that are part of an 
ArcMap document is to use relative 
paths. If you specify that you want to 
use relative paths, ArcView will be able 
to find the pieces of your ArcMap 
document if you move it or its 
components.  From the file menu, go to 
“map properties” and click the button 
“Data Source Options.”  Choose the 
radio button “Store relative path 
names.” 

 
Map Layers 
In addition to saving the entire workspace with a map document, you can save an 
individual map layer (.lyr).  This file will store all the formatting changes you have 
made to the layer. This is particularly helpful if you want to use the same layer, 
with the same symbology, in another map document.   As with the .mxd file, the 
.lyr file only includes information about the formatting and the path to the original 
data (generally a shapefile).  Moving your original data, or moving the .lyr file to 
another computer, will create problems. 
 
Naming Files 
Giving your files clear and consistent names will make working with ArcMap much 
easier.  You need to develop your own naming convention that makes sense to you.  
ArcGIS can work with file names that are more than 8 characters, but really long 
names can be difficult to view.  ArcGIS can also work with files that have spaces in 
their name, but this will create problems if you work with the Spatial Analyst 
extension.  Your file names should help you distinguish the content and version of 
your data. 
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Storing Files 
The most important thing in storing files for ArcMap is 
to think through a system BEFORE you start, so you 
can avoid moving files and disabling your map 
documents and layers.  Consider creating a new 
directory for each new mapping project.  Keep all map 
documents in that directory.  Create subdirectories for 
tabular data that are not associated with geographic 
files, geographic data, and images.  Keep map layers 
in the subdirectory for geographic data.  
 
 

 
 
Geodatabases 
With ArcGIS, ESRI has introduced a new geographic data model called a 
geodatabase.  Geodatabases allow for topologically integrated features, similar to 
coverages used in ArcInfo, and define rules for the behavior of different types of 
objects.  This provides a much more sophisticated approach to storing and 
managing data than using directories and subdirectories and works particularly well 
for sharing data.   
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Shapefiles & Vector Data 
 
Vector GIS 
Vector is the most common model for GIS data used in the social sciences.  It uses 
points, lines, and polygons to represent map features.  Vector GIS is excellent for 
representing discrete objects, such as parcels, streets, and administrative 
boundaries.  Vector GIS is not as good for representing things that vary 
continuously over space, such as temperature and elevation. 

 
Shapefiles 
ESRI created the shapefile format in order to 
represent vector GIS data in a simpler format 
than their coverage format used in ArcInfo.  As 
with other formats of geographic data, shapefiles 
link information about the location and shape of 
the map features to their attributes.  Shapefiles 
are made up of three or more files that need to 
be stored in the same directory in order for 
ArcView to recognize them as shapefiles.  Other 
GIS programs will allow you to use shapefiles, but 
geographic files from other GIS programs must 
be converted to shapefiles before ArcView can 
read them. 

 
.shp - the file that stores the feature geometry (point, line, or polygon) 
.shx - the file that stores the index of the feature geometry 
.dbf - the dBASE file that stores the attribute information of features.  When a  

shapefile is added as a theme to a view, this file is displayed as a feature  
table. 

.sbn and .sbx - the files that store the spatial index of the features. These two files  
may not exist until you perform theme on theme selection, spatial join, or  
create an index on a theme's shape field.  

.pjr – the file that stores information about the projection.  This will only exist for  
shapefiles with defined projections. 

 
 
 
The shapefile stores information about the 
shape of the map features, describing them 
in the “shape” field of the attribute table as 
point, line, or polygon.  It also stores 
information about the real world location of 
each vertex that makes up the map features. 
Using this information, ArcView can calculate 
area and perimeter for polygon features. 
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Adding Shapefiles to ArcMap 
You can add shapefiles to ArcMap in several ways.  From ArcCatalog, you can click 
and drag shapefiles right into ArcMap (click on the file name in ArcCatalog and hold 
down, dragging to either the table of contents or map window and letting go).  You 
can also add shapefiles from ArcMap using the “add data” button        or from file 
menu go to “add data.” 
 
Topology 
On of the biggest complaints about the shapefile format is that it does not contain 
information about topology. Topologic formats (like coverages used in ArcInfo) 
contain detailed information about the relationships among features in the same 
map layer.  This allows for a variety of operations to ensure the integrity of lines 
and polygons and to carefully edit and create new geographic features.  In creating 
the shapefile format, ESRI intentionally created something that is simpler than 
existing topologic formats for desktop (rather than professional) GIS users. 
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Adding XY Data 
 
 
Sometimes you will need to map a 
table that just has X and Y coordinates 
identifying specific locations but no 
shapefile associated with it. This might 
occur because a GPS (global 
positioning system) unit was used to 
collect the data or because that is the 
way a private vendor has chosen to 
distribute the data.  A table with X and 
Y coordinates is much easier to 
distribute than a shapefile, because it 
is smaller, does not involve multiple 
files, and is not ArcView-specific. 
 

 
 
 
In order to map the data in ArcView, the X and 
Y values will need to be included as separate 
columns in a dBASE or delimited text file.  You 
can add the table to ArcMap just as you would a 
shapefile (with the “add data” button), but you 
do not need to add it to ArcMap in order to map 
it.  From the tools menu, choose “Add XY Data” 
and browse to the table with the XY data.  
ArcMap will probably find the appropriate fields 
in your table; otherwise, use the dropdown 
menus to indicate the fields containing the X 
and Y values and click “ok.”  As with shapefiles, 
tables with XY data that you acquire may be 
projected.  If XY coordinates are in the form 
shown in the table above, they are unprojected. 
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Raster Data 
 
Raster GIS 
Raster data use grids made up of regular cells 
to represent spatially continuous data.  Each 
cell is assigned real world coordinates and an 
attribute value (such as precipitation level or 
elevation).  The user defines the cell size, 
allowing for very fine or course raster 
surfaces.  Even when the cell size is very 
small, you can see the individual square cells 
when you zoom in.  
 
In order to work with raster data in ArcView, you need the Spatial Analyst 
extension.  When raster layers have the same size cells, their values can be added, 
subtracted, multiplied, divided and queried using map algebra (a system developed 
by Dana Tomlin).   

Raster GIS layers are essentially images 
made up of individual pixels, just like 
scanned paper maps and aerial photographs.  
You can add raster data to ArcMap just as 
you do vector data, using the “add data” 
button menu option when the Spatial Analyst 
extension is available and is turned on.  If 
the raster data have no spatial information 
(for example, a scanned map that has not 
been georeferenced), ArcMap will not be able 
to display it with other map layers.   
 

ArcMap saves raster layers in its GRID format.  ArcCatalog recognizes GRIDs and 
other image formats (including BMP, JPEG, TIFF) as raster layers.  Images with no 
extension (such as “denst8” show below, left) are GRIDs.  If you view a GRID 
outside of ArcCatalog, it will consist of six or so files within a directory (see below, 
right). 

Raster Data in ArcCatalog Raster Data in My Computer 

pixels in scanned image 

cells in raster layer 
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Working with Projections 
 
Projections manage the distortion that is inevitable when a (mostly) spherical earth 
is viewed as a flat map.  All projection systems distort geography in some way—
either by distorting area, shape, distance, direction, or scale.  There are dozens of 
different projection systems in use since different systems work best in different 
parts of the world and, even within the same parts of the world, GIS users have 
different priorities and needs. The tools for working with projections in ArcView 9.0 
are more advanced than in ArcView 3.x, particularly in their ability to re-project 
layers with different projection systems “on the fly.” They look different from the 
projection tools in ArcView 8.3, although they essentially do the same thing. 
 
Recognizing the Coordinate System 
Map layers can be drawn according to a geographic coordinate system or projected 
coordinate system. Geographic coordinate systems indicate location using longitude 
and latitude based on a sphere (or spheroid) while projected coordinate systems 
use X and Y based on a plane. As long as computer screens and printed maps are 
flat, projected coordinate systems will be more appropriate for working with GIS 
data. Often you will not know the coordinate system used, particularly if you inherit 
data or download it from the Internet. If you are lucky, the map layer will include a 
.proj file which contains information about the coordinate system. You can look at 
the information in this file—the detailed spatial reference information—by clicking 
on the “general” tab of the layer properties from ArcMap. Alternatively, you can 
click on the “fields” tab of the layer properties from ArcCatalog, click inside the 
“shape” field and click on the “…” button to the right of “Spatial Reference.”  
 
If there is no projection information, you can map 
the data to determine its coordinate system. If 
the map units displayed in the gray bar below 
your map are in degrees, seconds, and minutes, 
then you know the data are in a geographic 
coordinate system. You may also recognize this 
because your maps look distorted. For example, 
when Philadelphia map layers are in a geographic 
coordinate system, the image appears to be 
sagging to the east. Map layers in geographic 
coordinate systems are sometimes described as 
“unprojected.” Map layers downloaded from the 
US Census Bureau are generally in this format. 
 
Working with “Unprojected” Layers 
In most cases you will want to convert unprojected map layers—those with a 
geographic coordinate system—to projected map layers. There are two steps 
involved in this process. First, you must create a .proj file “defining” the map layer 
as uprojected; then you can “project” the map layer using the projection of your 
choice. You can access the tools for doing this by clicking on the ArcToolbox icon 

  inside ArcMap. Click on “data management tools” and then “projections and 
transformations.” 
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To “define” the coordinate system for your unprojected map layer, click on the 
“Define Projection” wizard. First you will be asked to choose a data layer. If you 
added the relevant map layer to ArcMap, you will be able to find it in the dropdown 
menu. Otherwise you will need to click on the folder icon to locate your map layer. 

Then you can choose the coordinate system using the   button. Click the “select” 
button on the Spatial Reference Properties, then choose “Geographic Coordinate 
Systems,” “North America,” and “NAD 1983 Datum,” then click “okay.” You should 
not notice a difference in how the map layer is drawn as a result of defining the 
coordinate system. But as a result of defining it, there is now a .proj file associated 
with your map layer and you can look at the detailed spatial reference information. 
Before you define a layer as unprojected, ArcView will refer to it as “assumed 
geographic.” 
 

  
 
In order to project the map layer, click on the “Project” wizard. If you are 
projecting a shapefile, use the “Project” wizard listed under “Features.” If you are 
projecting a raster image, use the “project” wizard listed under “raster.” As with the 
“define” wizard, you will be asked to specify the map layer. Next, because you will 
be changing the original layer, you are asked to name the new layer that will be 
created. By default, ArcView will add “_Project” to the original name. Click on the 
button to the right of “Output Coordinate System” to choose your projection. Click 
on the “select” button on the Spatial Reference Properties, then choose “Projected 
Coordinate Systems.” Now you need to choose your projection. For relatively small 
areas like Philadelphia, the differences in projection systems (the distortion in 
shape, area, distance, direction, and scale) are minimal. You are best off choosing 
whatever projection system is most commonly used. In Philadelphia, that is State 
Plane 1983 (feet) Pennsylvania South. For the Philadelphia MSA, consider UTM zone 
18N. After making your selection, click “okay.” ArcView will indicate that there is a 
“Datum conflict between map and output.” In order to map your newly projected 
layer, create a new ArcMap document. 
 
Working with Projected Map Layers  
Sometimes the map layers you receive will already be projected but won’t carry a 
.proj file so you don’t know the projection. If you download the data, be sure to 
read any metadata files that may contain information about the project. If someone 
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has sent you the map layers, ask them about the projection. If these approaches 
fail, try mapping the data. You may recognize that the data are projected by the 
units showing in the gray bar below the map. If they are not in longitude and 
latitude, they are probably projected. As you work with a particular projection 
system, you will come to recognize the map units and range of coordinate values. 
For example, State Plane coordinates for Philadelphia are generally in feet and look 
like 2691607.78, 246268.98. UTM coordinates will be in meters and look like 
486850.72, 4430095.19. 
 
When you add a shapefile to ArcMap that the software recognizes as being 
projected but has no .proj file, ArcMap will usually warn you that spatial reference 
information is missing. Data that are projected but missing spatial reference 
information will look fine when they are drawn, but you may not be able to use 
ArcView’s “on the fly” projection capabilities, measurement tools, spatial join, or 
geoprocessing functions.  
 
 
 
 
 
 
 
 
 
If you know the projection, you can use the “Define Projection” wizard in the 
ArcToolbox. You will need to select the projection from the “Projected Coordinate 
Systems.” If a map layer is already projected AND defined, you can change the 
projection using the same tool. You will need to add the reprojected map layer to a 
new ArcMap document in order to see the results. 
 

Defining Projection for Data Frame 
Ideally, you will know and will specify the 
projection of each of your map layers.  
Alternatively, you can set the projection for your 
Data Frame for your map document.  All of the 
map layers listed under the Layers icon in your 
table of contents are in the same data frame (you 
can have multiple data frames in the same map 
document, although in most cases you will 
probably have just one). Right click on the word 
“Layer,” go to Properties, and make the Coordinate 
System tab active.  From here, you can choose a 
coordinate system (State Plane 1983 is in the 
“Projected Coordinate Systems” folder inside the 
“Predefined” folder). 
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Troubleshooting with Projections 
If you are unable to draw your map layers together or if your distance units do not 
make sense, you are likely experiencing a problem with projections.  If you are not 
able to figure out the problem, you may want to show your shapefiles to someone 
with more GIS experience. It is easy to get confused while using the “Define 
Projection” and “Project” wizards, and frequently the more you try to fix the 
problem, the more mixed up your projections get. Stay calm and don’t be ashamed 
to ask for help. You may also have luck returning to your original files (be sure to 
keep a copy of the originals before messing with the projection). 
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Georectifying Images 
 
Georeferencing allows you to convert a paper map into a GIS map layer.  
Essentially, the process assigns X and Y coordinates to points on your digital map 
image, shifting, rotating, and scaling your map so that you can view it as a map 
layer along with your shapefiles.   
 
Create a raster image 
Scan your paper map.  The higher 
resolution, the better. ArcMap can 
handle pretty big files, and it can work 
with lots of file types (.jpg, .tif, .bmp).  
If you have a choice, go with .tif. 
 
Add map image 
Add your image to ArcMap just as you 
would a shapefile or table, using the  
button or from the file menu, choose 
“add layer.”  Depending upon the size 
of your image, a dialogue box will ask 
you if you’d like to add pyramids.  Click 
“OK.”   
 
 
 
 
 
 
 
 
 
 
Don’t worry if you get a warning 
message that your image lacks 
projection information. The name of 
your image should now appear in the 
table of contents and draw in the map 
view window.  At this point, your image 
is in “pixel space” since there is no 
coordinate information.   
 
Add reference layers (shapefiles) 
Choose an existing shapefile that 
contains spatial information that will 
help you georeference your paper map 
(choose more than one, if necessary).  
You need a shapefile that covers the 
same extent as your paper map and 

that contains several points that you 
can identify visually on your paper map.  
In the table of contents, put your 
reference layer(s) on top of your map 
image and highlight the reference 
shapefile.  Right click and choose “zoom 
to layer.”  From the view menu, choose 
toolbars  georeference.  From the 
georeferencing menu, choose “fit to 
display.”  Now your reference layer(s) 
should draw on top of your map image 
in the view map window. 
 
Add control points 
Click the “add control points” button.   
 
 
 
 
Create your first control point on your 
image by clicking once on a point you 
can also identify on your shapefile.  
Then click on the shapefile in the 
corresponding spot.  Double click to 
create a control point.  You may find it 
easier to use the magnifier window 
(from the window menu, choose 
“magnifier”).  Create additional control 
points.  After doing this two or three 
times, your paper map should shift 
significantly to line up with the 
shapefile.  Continue to add control 
points as long as doing so improves the 
alignment. 
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View Links 
Click on the “view links” button to view 
the coordinates of each of the control 
points you’ve created.  
 
  
 
 
 
The “residuals” column indicates the 
amount of error.  You may improve the 
alignment of your image by deleting the 
point(s) with the greatest error.   
 

If you have six or more control points, 
you can perform a second order If you 
have six or more control points, you 
can perform a second order 
transformation; if you have twelve or 
more control points, you can perform a 
third order transformation.   
 
Rectify Image 
In order to permanently save the 
transformation, choose “rectify”  
from the georeferencing menu.  ArcMap 
will create a new image (rather than 
changing your original data).  Check 
the ArcMap Desktop Help if you want 
information about choosing a 
resampling type. 
 
You don’t have to rectify your image. If 
you want to revert to your original (un-
georeferenced) image, from the 
georeferencing menu, choose “reset 
transformation.” 
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Displaying Point Data 
 
ArcMap offers a wide range of colors and symbols for representing your point data.  
The real strength of a GIS is in allowing you to use different symbols to represent 
different values, linking your attribute data to your spatial data. 
 
Single Symbol 
The default in ArcMap is to represent all 
points with the same size, shape, and color 
symbol. This is how ArcMap will display your 
point shapefiles when they are first added to 
a map document or when you create them 
through geocoding or adding XY data.  Open 
the layer properties (double click on the 
shapefile name or right click and go to 
“Properties,”) and click on the “Symbology” 
tab. In the box on the left side, “single 
symbol” will be highlighted.   
You can change the size, shape, or color of the symbol by clicking on it, but as long 
as “Single symbol” is selected, all of your points will appear the same. 
 

Unique Value 
Unique value allows you to use a different 
symbol for each of the points in a 
shapefile. This can work well for small 
files (10 or fewer points) but can quickly 
be overwhelming for larger files.  From 
the symbology tab, click on “categories” 
(under “Show:”), and “unique values.”  
Using the “Value:” dropdown menu, 
select the field with the values you wish 
to use to represent your points, and click 
the “Add All Values” button.   

 
ArcMap will list a symbol for “<all other values>” that you can remove by taking 
away the check mark.  You can change the individual symbols by clicking on them.   
You can make changes to all of the symbols, or selected symbols (hold down the 
shift key to select two or more) by right clicking. To remove a value, right click on it 
and choose “Remove Value(s).”  Use the black arrows on the far right to move 
values up and down (the order here will be the order your values appear in the 
legend on your map).  
 
Graduated Symbol 
Graduated symbols allow you to have different size symbols to represent different 
attribute values.  With the symbology tab active, click on “Quantities” and then 
“Graduated symbols.” From the “Values:” dropdown menu, select the field with the 
values you wish to use.  he default is five categories, so five value ranges 
represented by different size dots should appear below. Use the “classes” dropdown 
menu to change the number of categories. 
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There are many ways to break up value 
ranges into categories. The default is 
“Natural Breaks,” which uses Jenks 
optimization to identify grouping of 
values that minimize within group 
differences. To change this, click on the 
“Classify” button and use the Method 
dropdown menu to choose a different 
classification system. You can also 
adjust the cutoff points by moving the 
blue vertical lines in the histogram 
below that show the frequency of 
values. Alternatively, you can change 
values manually on the previous screen 
by clicking on them (you will only be 
able to change the ending value).   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
For more on symbology, see Getting to Know ArcMap, Chapter 5, “Symbolizing 
features and rasters,” pp. 83-114. 
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Displaying Area (Polygon) Data 
 
The symbols in ArcMap can be used for any type of data—points, lines, or polygons.  
The following symbology schemes work particularly well with area (polygon) data. 
 
Graduated Color 
You can use different colors—or 
different shades of the same color—to 
represent different values to create 
choropleth maps. From “Layer 
Properties,” click on the Symbology 
tab.  On the left side of the screen, 
click on “Quantities” and “Graduated 
Color.” Choose the field with the 
values you wish to use.  Use the 
“Classes” dropdown menu and the 
options in “Classify” to change the 
number of categories or method for 
breaking values into categories.   
You can normalize a value in order to transform it into a rate using the 
“Normalization” dropdown menu. For example, in order to show the percent of 
households receiving public assistance, normalize the total number of households 
receiving public assistance by the total number of households. Choropleth maps are 
best used to represent rates rather than raw counts since raw counts can look 
deceptively large for large polygons (alternatively, you can create new fields in your 
attribute table corresponding to rates). 
 

Graduated color works best when you use the same 
shade of a single color, with lighter shades representing 
lower values and darker shades representing higher 
values. But keep in mind that it may be impossible to 
distinguish between more than four or five shades of the 
same color, depending upon the quality of your printer.  
To fine-tune colors, go to “more colors” when choosing a 
color from the symbol selector. Here you can play with 
the hue(H), saturation(S), and value(V). 

 
Fill Patterns 
You can use different patterns in addition to, or 
instead of, using different colors to represent 
different values.  Patterns are particularly helpful 
when you are restricted to printing maps in black 
and white. Choose “Graduated Colors” from the 
Symbology tab and select the field with the values 
you want to display. Set the number of classes and 
the method of classification, so that you are happy 
with the value ranges. Then click on the symbols and 
change the fill using the symbol selector.  Click on 
the Properties button to fine-tune the fill pattern. 
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Dot Density 
Dot density maps use randomly placed dots 
within polygons to represent different values.  
They provide an alternative to using 
choropleth maps to represent raw counts, 
although it is important to remember (and 
communicate to anyone reading your map) 
that the points do not represent precise 
locations, as they do in a point layer. To 
create a dot density map, open the Layer 
Properties and make the Symbology tab 
active. Click on “Quantities” and “dot 
density.” 

 
From “Field Selection,” choose the field you wish to use as the basis for the map.  
Counts (such as the total number of households on public assistance) are 
appropriate for dot density maps, but averages, medians, and rates are not.  
Choose your dot size, or keep the default (which is advisable, at least to start).  
The “Min,” “Mean,” and “Max” boxes will give you a preview of how your map will 
look. The “Dot Value” indicates how many units each dot represents. Change this as 
needed to create dot densities that have enough dots to show variation but not so 
many that they are all on top of each other. You can change the color of the dot by 
clicking on it under “Symbol” in the top right part of the screen. Checking “maintain 
density” will ensure that the dot density looks the same as you zoom in and out (by 
making the dots bigger and smaller). 
 

Pie Charts 
Charts are good for showing multiple values 
and the relationship between values on 
different variables. Pie charts are especially 
good for showing proportions. For example, 
individual pie pieces can be used to show the 
breakdown in race for the population in a 
census tract. For the pies to work, you must 
be able to put every person into a racial 
group, or you must use an “other” category.  
Pies contain a lot of information, so it can be 
difficult to display them clearly.   
 

To create pie charts, click on “Charts” and “Pie” from the Symbology tab.  Holding 
down the shift key, select the fields that you want to include. Make sure that 
together, they add up to 100 percent (you may need to create and calculate a new 
“other” field in your attribute table before using charts).  Click on the “Background” 
button to change the color or fill (“Hollow” or white backgrounds might be best, so 
that you don’t have too many colors in your map). If you check “Prevent Chart 
Overlap,” ArcView will use “leader lines” to indicate where the pie charts belong if 
there is no room to display them within the map feature. Click on the Properties 
button to make adjustments to the look of the pie (3D, rotation, height). 
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Click on the Size button if you want to 
have different size pie charts 
depending upon the total (such as 
total population). If you choose to 
“Vary size using a field,” you may 
need to exclude records with a zero 
value. To do this, click on the 
Exclusion button and, using the 
appropriate field name, create an 
expression such as “[TotalPop] = 0.”  
You may need to play with the 
minimum size on the previous screen 
to make the maximum size pie chart a 
reasonable size. 

 
Bar/Column Charts 
Bar charts can be used to compare values on 
two or more variables that do not represent 
proportions (they don’t have to be subsets 
that add to 100 percent). For example, the 
map on the right compares the total 
population by block group to the total 
number of households. To switch from 
column (vertical) to bar (horizontal) charts, 
go to Properties on the Symbology tab of 
Layer Properties and switch the radio button 
under “Orientation.” 
 

 
Stacked Charts 
Stacked charts can be used to 
compare values on two or more 
variables (such as race) that are 
subsets of a larger variable (such as 
total population) when you don’t 
know, or don’t want to display, all of 
the subsets. You have many of the 
same options for formatting (size, 
color) that you have with the other 
types of charts. 
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Labeling Features 
 
Labeling features in ArcView can be frustrating and tedious, but labeling 
features well is important to making your maps readable, so it’s worth the 
effort to learn. 
 
Using Text Boxes to Label Features 
You can place text on a map in order 
to label map features. This can work 
well if you only have a few map 
features to label.  Click on the button 
marked “A” on the drawing toolbar.  
This will bring up four buttons.   
Click on the “A.”  Click on your map where you want your text to appear and 
type your label in the text box. Hit the enter key, or click your cursor outside 
the text box to complete.  You can move the text around using the “Select 
Elements”     tool.  Double clicking on the text will bring up the Properties, 
where you can change the size and font (using the “Change Symbol” button). 
 
The callout text tool       works similarly, except 
that it allows you to place your text away from 
the map feature while still indicating what is 
being labeled. Click on the tool and then click on 
your map feature. Before letting go, you can 
move the cursor to where you would like the label 
to be. Type your label. Using the “Select Items” 
tool, you can move the text box so that it is 
closer or further from the map feature. 
 
 

A third option is the spline text tool.  
This allows you to write text along a 
curved line. This works well for 
labeling rivers and curvy roads. Click 
on the spline tool, then click on the 
starting point for your label. Continue 
to click along the curve (you don’t 
need to make many clicks) and double 
click to finish. Then type your label in 
the text box. You will probably need to 
try this several times to get a label 
with which you are happy (just click 
on the label with the “Select 
Elements” tool and hit the “delete” key 
to delete a label). 
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Manually Placing Labels 
Using the label tools in ArcMap, rather than the text tools, allows you to use 
the values in a layer’s attribute table for your labels (in other words, you 
don’t have to type the label out as you do with the text tools).  By manually 
placing labels, you also avoid having your labels act as a group, which means 
it’s easier to move or edit a single label. Before you can use the label tools in 
ArcMap, you need to indicate which field in the attribute table of your map 
layer you want to use as the basis for labels.   
From Layer Properties, click on the “Labels” tab.  Leave the “label features in 
this layer” box empty. Choose the appropriate field from the Label Field 
dropdown menu. Click on symbol to change the size, style, or font for your 
labels.  (Guessing what size to make your labels is difficult and you will 
probably need to make small adjustments after seeing what works). 
Using the “Placement Properties” button, you can instruct ArcView what to do 
about duplicate labels.   
 
The “Scale Range” allows you to 
instruct ArcView when to draw or not 
draw labels, depending on the extent.  
In order to do this, you need to know 
the exact scales you’ll be using (so 
you probably just want to leave this 
alone). The “Label Styles” button 
gives you access to some fancier label 
options. The highway labels are 
particularly helpful.   
 

Now you can use the label tool to manually label your 
map features.  Click on the button marked “A” on the 
drawing toolbar and choose the “Label” tool      .  The 
“Labeling Options” window will open. Decide if you 
want ArcView to decide the best label position or if you 
want to determine that yourself. The “Choose a style” 
radio button gives you access to those fancier labels 
again.  You can move these labels (using the “Select 
Elements” tool) and change their size and style 
(double click to bring up Properties). You can delete a 
label by clicking on it and pressing the delete key. 

 
Auto Labeling 
You may find it easier to automatically label all of your features. This saves 
time if you are happy with the way the labels look, but it offers you much 
less control over the label placement. When you automatically label features, 
the labels are “dynamic” so changes you make to one (moving it, changing 
the style) are made to all. To label your map features automatically, go to 
Layer Properties, click on the Label tab, and put a check mark in the “Label 
Features in this layer” box. You can also label automatically by right clicking 
a map layer and going to “Label Features.”  To delete your labels, you’ll need 
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to return to the Label Properties box and remove the check mark from “Label 
Features in this layer” box or right click and go to “Label Features.” 
 
Converting Labels to Annotation 
One solution to the problem that dynamic labels 
present for fine-tuning is to convert them to 
annotation, so that they function as individual text 
boxes as they do with manually placed labels. To 
do this, right click on your map layer after labeling 
it and go to “Convert Labels to Annotation.” 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Cartographic Modeling Laboratory                                                                                          ArcView 9 Manual 
 

 31

Designing Map Layouts 
 
Displaying data so that you can analyze spatial patterns on a computer 
screen is one thing; printing out a map for other people to look at is another.  
ArcMap thinks of these as distinct functions and makes available a series of 
tools for designing map layouts that you don’t need until you are ready to 
print. 
 
Layout View 
When you open ArcMap, you are in “Data 
View” and use the Tools toolbar to navigate 
your map.  When you switch to the Layout 
View, you have access to a different range of 
tools and use the Layout toolbar to navigate.  
To switch to “Layout View,” click on the icon 
at the bottom of your map display that looks 
like a piece of paper (next to the globe icon) 
or, from the View menu, go to Layout View. 
 

In Layout View, you get a much 
better idea of how your map will 
look when it’s printed. ArcMap will 
automatically place a border (“neat 
line”) around your map. You can 
change this by right clicking on it 
(so the line is turquoise and 
perforated) and going to 
“Properties.” Click on the “Frame” 
tab.  From here you can choose a 
different style or color frame (to 
get rid of it altogether, choose “no 
color” from the color selector).  
You can also change the 
background color and add a 
shadow (to add a shadow, you’ll 
need to change the X and Y offset 
to something other than 0). 
 

To make your map larger or smaller on the 
page, you can use the zoom tools on the Tools 
toolbar or on the Layout toolbar. The Layout 
toolbar also includes a pan tool that you can 
use to move your whole layout. To move just 
your map (and not the whole page), use the 
pan tool in the Tools toolbar. The fixed zoom 
tools in the Layout toolbar work like the ones 
on the Tools toolbar. The “Zoom to whole 
page” button       is especially useful. 

Tools toolbar 
 
Layout toolbar 
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One the biggest differences in Layout View is that many 
more options in the “Insert” menu become active.  These 
options allow you to add elements—including a title, 
legend, north arrow, scale bar, and image—to your 
layout.  Each of these will be separate objects in your 
layout that can be moved and resized through their 
Properties. You won’t see any of them if you switch back 
to Data View since they are meant to clarify printed 
maps, not help you interpret your map on screen (in fact, 
the layout view is probably more confusing to look at 
from the screen because it adds so many elements and 
usually shrinks your map). You can add text in the Layout 
View, but you are better off trying to label features from 
the Data View, using the label or text tools. 
 

Working with Grids and Rulers 
You can bring up a number of options aimed at helping you to place the 
objects within your layout by right clicking in your layout outside of the neat 
lines. From “Options,” you can specify ruler units and turn on and off rulers 
and grids when the “Layout Options” tab is highlighted.  Choosing to “snap” 
to the grid or rulers will help you to line up objects, but it will also limit your 
ability to make fine-level adjustments. 
 
Adding a Title 
To add a title, from the Insert menu go to “Title.”  Type your title in the text 
box and hit the enter key or click the cursor outside the text box.  Double 
click on the title to bring up the Properties where you can make changes. 
 
Adding a Legend 
Unless your labels are able to fully explain your map features, you will want a 
legend on your layout.  ArcMap gives you great flexibility in formatting your 
legend, and all the choices can be overwhelming. To add a legend, from the 
Insert menu go to “Legend.”  Your first choice is what map layers you want 
included.  ArcView will guess that you want to include all active layers.   
 
This may not be the case if you have 
layers such as a county boundary, rivers, 
or other obvious features that don’t need 
to be included in the legend. To remove a 
layer from the legend, click on its name 
on the right side of this first screen and 
click on the “<” button.  The order your 
layers are listed under “Legend Items” 
will correspond to the order in which they 
appear in your legend. To change the 
order, click on the name and hit the up or 
down arrows (don’t worry; this won’t 
affect the order in which they are drawn).   
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If you want more than one column in your legend, make the adjustment 
here. To see what your legend will look like (before working your way 
through the rest of the screens), click the “Preview” button. If you are 
satisfied with it, you can click the Finish button and skip the other steps.  
Otherwise, click the “Preview” button again and click “Next.”   
 
On the second screen of the Legend Wizard, you can give your legend a title 
or leave the word “Legend” as the title (or just leave it blank). The third 
screen allows you to create a frame and shadow around your legend (not 
necessary, but depending upon your layout it may be helpful, particularly if 
you gave your layout a background color). On the fourth screen, you can 
change the symbols and symbol size used to represent lines and polygons in 
your layout. On the final screen, you can make adjustments to the spacing 
between items in your legend. Click “Finish.”  To make changes after you 
have created your legend, double click on it to bring up Properties. 
 
Adding a North Arrow 
You may decide that a north arrow is 
not necessary (unless you choose to 
rotate your map so that north is no 
longer towards the top of the page; in 
that case, it is definitely necessary).  
If you do wish to add a north arrow, 
from the Insert menu go to “North 
Arrow.” Choose a style from the 
“North Arrow Selector” (preferably 
something simple, and small).  You 
can move it around on your layout by 
clicking on it. Double click to change 
the size or style. 
 

Adding a Scale Bar 
To add a scale bar, you must identify the 
appropriate units for your map. You can set these 
from the Data View or Layout View. From Layout 
View, right click in the layout (anywhere inside the 
neat lines), go to Properties, and make the General 
tab active. From the map units dropdown menu, 
choose the units used for the original map 
projection (see “Working with Projections”). Once 
this is set, you can choose any display units you 
want.   
 

To add your scale bar, from the Insert menu, go to “Scale bar.” Click on a 
style and hit “OK.”  Your scale bar should appear on your map. You can move 
or resize it by clicking on it. Double click to bring up the Properties, where 
you can change the number of divisions as well as the font size (by clicking 
the Symbol button or from the format tab). 
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Adding Scale Text 
You may wish to include a text 
description of the map scale, 
particularly if this is important to your 
audience and you deliberately chose a 
scale (as opposed to maximizing the 
size of your map based on the size of 
your page). To add scale text, from 
the Insert menu go to “Scale Text.”  
Double click on the scale text in your 
layout to bring up the Properties, 
where you can make changes to the 
format and units. 
 
Rotating a Map 
You can rotate your map to better fit the page or to make it easier to read 
(just because you can do this doesn’t mean it’s a good idea). If you do this, 
make sure that you have a north arrow on your map.  As you rotate your 
map, your north arrow will adjust to indicate which direction is north. From 
the View menu, go to Toolbars (or just right click on a gray part of the GUI) 
and Data Frame Tools.   
Click on the “Rotate Data Frame” button, then click and 
hold down on your map, moving your map to change the 
rotation.  To restore the original orientation, click on the 
“Clear Rotation” button. 
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Using Map Templates 
 
Using map templates can save you time and lead to greater consistency in 
your printed maps. You can use ArcMap’s custom templates or design your 
own. 
 
Opening map templates 
If you are going to use a map template, you 
need to decide this before you start adding data 
to your map document.  When you open 
ArcMap, choose to start using ArcMap by 
clicking on the template radio button in the 
dialog box. The templates listed in the General 
and Industry tabs provide empty layouts while 
those in USA and World tabs also include map 
layers.   
Choose a template by double clicking on its name or clicking once and hitting 
“OK.” Don’t worry if the template includes colors or elements that you don’t 
want.  It only provides a starting place and you will have the opportunity to 
customize it. 

If you have turned off the opening dialog box 
(by putting a check in the “Do not show this 
dialog again” box when you opened ArcMap 
previously), go to the File menu and “Open.”  
From the “File or type” dropdown menu, 
choose ArcMap Templates (*.mxt). Navigate 
to ArcGIS’s template folder (probably 
c:\ArcGIS\arcexe82\Bin\Templates) and 
choose a template. You can’t preview the 
templates if you access them this way. 

 
Using map templates 
If you selected a map template that contains no data, you must add one or 
more data layers to your map document. Once you do, the legend and other 
elements of your layout will be automatically created based on the template 
design. Make changes to the data frame (which contains your map), legend, 
scale bar, and north arrow from the Properties dialog boxes (right click on 
any of these and go to Properties).  You can also move the elements around 
(click and hold down) as needed. Notice that when you use map templates, 
ArcMap opens in Layout View. You can still switch back and forth to Data 
View using the             buttons. 
 
Using inset map templates 
For the map templates that include insets, you’ll need 
to add at least two layers. When you open one of 
these templates, you’ll see Layers 1 and Layers 2 
listed in your table of contents.  By having two 
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separate groups of layers, you can have two maps in 
your layout.   
This might be two different maps or the same map at different extents.  
Right click on “Layers” and go to “Add Data” to select the map layer for the 
main map in your layout. Then right click on “Layer 2” and, from “Add Data,” 
find the map layer for the inset map. 
 
Creating your own template 

You can create your own map template by 
modifying an existing custom template or 
starting from scratch. Once you have 
created a layout that you would like to 
reuse, go to the File menu and “Save As.”  
From the “Save as type” dropdown, choose 
“ArcMap Template (*.mxt).”  If you are not 
in the ArcGIS Template folder, navigate to 
it (c:\ArcGIS\arcexe82\Bin\Templates).   

Give your template a name and hit “Save.” Your new template will appear 
under the “General” tab when you choose to start using ArcMap with a 
template (You must save your template in the Templates folder in your 
profiles location in order for it to appear under the “My Templates” tab. If 
you create a new subdirectory in the Bin/Templates folder, your templates 
will appear under a new tab with the name of your subdirectory). 
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Making Inset Layouts 
 
You may need to create a printed map that includes more than one map, 
either because you can’t fit everything (such as Alaska and Hawaii) on your 
main map or because you want to zoom into a small area for your main map 
and indicate on a smaller map what area that covers.   
 
Adding Group Layers 
Most of the time you will only need one data frame in a map document. 
Working with data frames can make your map document complicated and 
prone to crash. But if you need to include more than one map in your layout 
(including the same map at a different extent), you’ll need two or more data 
frames.  When you open ArcMap, you’ll just have one data frame (called 
“Layer”) and every map layer you add to your map document becomes part 
of this frame. To create a second data frame, from the Insert menu go to 
“Add Group Layer.”   
 

To add new data to a particular data frame, right 
click on its name and go to “Add Data” or highlight 
its name and use the Add Data button       (or, 
from the Insert menu, go to “Add Data”).  If you 
want to move a layer to a different data frame 
once it is in ArcMap, right click on it and go to 
“Copy.” Then right click on the name of the data 
frame where you want to move it and go to “Paste 
Layer.” To remove the original copy of the layer, 
right click on it and go to “Remove.” The layers in 
only one data frame can be displayed at a given 
time. It does not matter which one is listed first in 
the table of contents; it matters which one is 
active. To display the layers in a data frame, right 
click on its name and go to “Activate.” 

 
Creating Extent Rectangle 
If you want to have an overview map that 
shows on a larger map the outlines of the area 
your detailed map includes, you’ll need to 
create an extant rectangle. To do this, follow 
the instructions above to create two map 
layers: a detail layer and an overview layer. 
Zoom in on your detail layer in the map view 
and resize it in the layout view so that it looks 
the way you want. Then right click on the 
overview layer in your table of contents.  From 
“Properties” click on the “Extent Rectangle” tab. 
Move your detail layer from the left to the right 
side. Click on the “Frame” button to make 
changes to the outline of your box.  
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Exporting Maps 
 
If you just need paper copies of your maps, you will probably have the best 
results printing them from ArcView. But if you need to insert maps into 
Power Point or word processing files, will need to export your maps. 
 
Exporting Maps 
You can export a map from ArcMap when you are in Data View or Layout 
View. However, if you want your exported map to include titles, legends, 
scale bars, north arrows, and anything else you added to the layout, you’ll 
want to export from Layout View. From the File menu, go to “Export Map.”  
There are many options for export formats in the “Save as type” drop down 
menu.  
 
.EMF: If you are working with vector data and need to import a map into 
Power Point or MS Word, .emf works very well. The one drawback is that you 
must have ArcView installed on the computer where you open your .ppt or 
.doc or your map symbols may be corrupted. These files will probably get too 
large to work with if you have raster data.  
 
.PDF: The .pdf format allows you to open the map directly (without inserting 
it into PowerPoint or MS Word) as long as you have Acrobat Reader. This is 
probably the best option if you need to send someone a map or post a map 
on the Internet.  
 
.JPG: The .jpg format will compromise the quality of your image, so be sure 
to click on the “options’ button when you export and increase the resolution 
to at least 200 dpi. The .jpg format is good because it stores your map in a 
fairly small file and, unlike .emf, your map will not be compromised if you 
open it on a computer that does not have ArcView installed.  
 
.TIF and .EPS: The .tif and .eps formats work well if you are going to open 
your maps in a graphics software package, but they result in larger files.  
 
Screen Capture: If all else fails, you can take a screen capture (print 
screen, or alt + print screen) and crop the image, but this will not result in a 
presentation-quality map. 
 
Inserting Maps into Power Point 
Save your map as an .emf. With Power 
Point open, go to the Insert menu, 
“Picture,” and “from file,” then Navigate to 
you map image and click “Insert.” You may 
notice that there is a lot of white space 
around your map. Eliminate this using the 
crop tool. You must have the map image 
active (click on it so that you see small 
squares at the corners). Click on the crop 
tool      and crop the image by clicking on 
one of the small boxes and dragging the
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cursor (if you do this without having the crop tool active, you will shrink the 
whole image). You are probably better off creating map titles in Power Point 
rather than ArcView. Also, if you are making a map specifically for Power Point, 
consider making the legend larger than usual (14 points or more) so that your 
audience can read it. 
 
You may encounter problems exporting maps to PowerPoint if you try to 
show the PowerPoint presentation on another computer if it doesn’t have 
ArcView loaded. Your markers (the dots and squares used to represent points 
on your map) may come up looking like # and other strange symbols. This is 
because your exported maps are relying on the ESRI typefaces to draw these 
markers correctly. If ArcView isn’t loaded, those typefaces are not available 
and PowerPoint comes up with the closest approximation from other 
typefaces. There is no good way around this problem. If you use .pdf files or 
screen captures, you can avoid the problem but will sacrifice image quality 
and flexibility. 
 
Inserting Maps into Microsoft Word 
You will have greater control over the placement of your map if you import it 
to Power Point first, then copy it into Word. From Power Point, click on your 
map image and hit the copy button (or Ctrl + C). In MS Word, hit the paste 
button (or Ctrl + V). You can move your map around by clicking and 
dragging it or by using the arrows on the right side of your keyboard. Hold 
down the Control key while using the arrow keys to make small moves 
(“nudge”). You can crop your map in MS Word. From the View menu, go to 
Toolbars and “Picture.” 
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Working with Tables 
 
Attribute Tables for Shapefiles 
Every shapefile has an attribute table 
associated with it.  You can open the table 
by right clicking on the shapefile name and 
going to “open attribute table.” The table will 
have as many rows, or records, as it does 
map features. The total number of records 
will be shown at the bottom of your table.  
here can be any number of columns, or 
fields. Two are standard: FID, the feature 
ID, and Shape, which can be point, polyline, 
or polygon. The rest of the fields will vary.   
There should be a field that identifies each map feature with a unique name, such 
as a census tract number or neighborhood name. There may be additional fields 
identifying attributes of the map feature (type of crime at a particular address, 
number of people living in a census tract). 
 
Other Attribute Tables 
Often you will have attribute data in a table separate from your shapefile.  For 
example, you may have a census tract shapefile with no attribute information and a 
table with all of the 2000 census tract data.  ArcMap can read dBase (.dbf) and 
comma-delimited text tables (.txt), but will allow editing for only .dbf tables (you 
can convert .txt tables to .dbf in EXCEL, SPSS, ACCESS, or in ArcMap).   
 
You can add attribute tables to ArcMap just as you do shapefiles, using the “add 
data” button or, from the file menu, “Add Data.”  When you add a table, ArcMap 
will switch the table of contents from the “display” to “source” tab.  You can only 
see tables listed when the “source” tab is active. Open the table by right clicking on 
its name in the table of contents and going to “open.” Your table should have at 
least one column that contains geographic information. This might be a street 
address, X and Y coordinates, census tract number, zip code, or other identifier that 
will allow you to match the information in your attribute table to map features in a 
shapefile. 
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You can work with tables—sort values, freeze columns, generate summary 
statistics, select records, and export tables—without worrying about corrupting your 
data.  You cannot change any of the data in your table unless you go to “start 
editing” from the editor toolbar… except to add new fields or delete existing fields.  
 
Sorting Records 
You can sort values in an attribute table by right 
clicking on the field name and going to “sort 
ascending” or “sort descending.”   
 
Freezing Columns 
Freeze a column (meaning that it will remain in 
view even as you scroll) by right clicking on the 
field name and going to “Freeze/Unfreeze Column.”   
 
Summary Statistics 

You can bring up summary statistics for any 
numeric field (numeric fields will be justified 
right) by right clicking on the field name and 
choosing “Statistics.”  You can obtain 
summary statistics on additional fields from 
the drop down menu. 

 
Selecting Records 
You can select a subset of your records to look at 
more closely in a number of different ways.  You 
can highlight an individual record (row) by 
clicking in the gray area at the far right side of 
the table.  To highlight multiple records, hold the 
control key down. At the bottom of the table, 
ArcMap will indicate how many of the total 
records are highlighted. Click on the “Selected” 
button to view only the selected records. 
 
You can switch the selection, so that all of the highlighted records become un-
highlighted and all un-highlighted records become highlighted.  From the options 
menu, choose “Switch Selection.”   
You can also select all records or clear selection from the options menu. 
 
Exporting Tables 
You may need to export your table from ArcMap, because you have made changes, 
need to convert a .txt table to .dbf, or for any other reason.  With your table open, 
go to the options menu and “Export.” 
 
Delete Field 
You can delete a field by right clicking on its name and going to “Delete Field.”  
ArcMap will give you a warning that the deletion is permanent and not reversible.  
Do this with caution. Changes will be permanent not just within your map 
document, but in your original file on your hard drive, as well.   
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Converting Excel Worksheets to DBF Tables 
 
Excel is not the only way to create new tables or to convert tables to .dbf format. 
You can also use SPSS, ACCESS, or other statistical and database packages. But in 
many cases, Excel will be the only software available for the job. 
 
Excel can open a wide variety of formats, including delimited or fixed width text, Lotus, Quattro 
Pro, and web pages.  If you are working with one of these other formats and need to make 
changes to your data in Excel, it is probably best to save the document as an Excel worksheet.  
In order to add or edit a table in ArcView, it must be in .dbf format.  When you save an Excel 
document, you can choose another format using the “save as” options.  But even if you choose 
.dbf at this stage, you may encounter problems. For example, your new .dbf file may not 
include all of the cells in your original file, or the columns may be formatted as strings rather 
than numbers. Here are some things you can do to increase the odds of preserving your data 
during the conversion. 
 
1.  Limit your column headings to 10 
characters. Excel will let you have infinitely 
long column names, but ArcView will shrink 
them.  It’s better to come up with your own 
abbreviated names than to risk losing 
important information when ArcView shrinks 
the names. 
 
2.  Check your columns to be sure that they 
are formatted correctly as strings (left 
justified) or numbers (right justified). Also, 
look for rows at the very top that may be 
blank or contain data that are different from 
the following cells.  For example, you may 
have a column named “programs” with 
values ranging from 2-10 for all of your 
cells, but the first cell is blank or has an 
“NR” for “not reported.” This column will be 
formatted as a string when you convert to 
.dbf and open it in ArcView, because .dbf 
takes its cue from the first data cell in the 
column. To avoid this problem, you can re-
sort the data so that the blank cell is not on 
top, or you can put in an appropriate 
numeric value (such as 0 or 999 for missing 
data). You can convert a string field to 
numeric in ArcView, but it’s easier if you 
start with the right format. 
 
 
3.  When you are ready to save your data, 
highlight all of the cells that contain values 
(including the column names). From the 
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Insert menu, go to “Name” and “Define.”  
Type in a name (type anything; it doesn’t 
matter), click “Add” and “OK.” This 
increases the likelihood that all of your cells 
will be included in the new table.   
 
 
Now you can save your document.  First, save all changes in your Excel document. Then, from 
the File menu, choose “Save As” and select “DBF4” from the dropdown menu. First Excel will 
give you a warning that the .dbf format doesn’t support multiple worksheets and that only the 
data in the top (active) worksheet will be saved.  Click “OK.” 
 
 
 
 
 
 
 
 
Excel will then give you a second warning message, because .dbf is very different from .xls and 
some formatting may be lost.  Just click “OK.”   
 
 
 
 
 
 
 
 
 
When you close Excel, Excel will prompt you again with these messages, as though it is still 
incredulous that you would choose any format other than Microsoft’s. Humor the software and 
go through these two steps again. As soon as you add your table to ArcView, look it over to 
make sure that all of the data came through and are in the right format.  
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Calculating Values in Tables 
 
You may find it easier to edit your attribute tables outside of ArcView, but ArcView 
has fairly sophisticated tools for calculating values. In ArcView, you can edit values 
in an existing field or create a new field and calculate new values. Keep in mind 
that you cannot change the format (text, integer, long integer) of an existing 
column, so if you need to transform the format of a column, you will need to create 
a new field. 
 
Creating a New Field 
To create a new field, open your table in ArcMap 
(you can also add fields from ArcCatalog).  This can 
be a free-standing table or one that is associated 
with a map layer, but only .dbf tables can be 
edited. Click on the “options” button (if you do not 
see the options button, make your table bigger; it’s 
in the lower right corner). Go to “Add Field.”  If this 
option is grayed out, you do not have permission to 
edit the table. Most likely, this is because the “read 
only” box is checked in the table properties. This 
happens automatically when you copy data off a 
cd. To change this, find your table on your hard-
drive (through Windows Explorer or My Computer, 
not through ArcCatalog), right click, and go to 
“properties.” Remove the check mark next to “read 
only.” 
 
From “Add Field,” give your field a name.  Do not use ?,&,$,#,@,*,!,~ or spaces 
and keep your field name to 10 or fewer characters.  From the dropdown menu, 
choose the type of field. 

 
Short integer: numeric, no decimal place, up to 19 characters 
Long integer: numeric, no decimal place, up to 19 characters 
Float: numeric, with decimal place, (default is one place before  

decimal and 11 after) 
Double: numeric, with decimal place (default is 7 places before  

the decimal and 11 after) 
Text: numbers or letters, specify length (default = 50 characters) 
Date: can include time and date 
Blob: up to four characters; Boolean 
 

Finally, determine the scale (number of places) and precision (number of places to 
the right of the decimal point), or accept the defaults by leaving them 0. 
 
NOTE: You can also add a new field from ArcToolbox (under “Data Management 
Tools”, then “Add Field”). 
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Calculating Values Outside an Edit Session 
To calculate the value of your new field (or an old field), right click on its name and 
go to “Calculate Values.”  ArcMap will ask you if you are sure that you want to 
calculate values outside an edit session, warning that you will not be able to undo 
your results.  Say “yes.”    
 
 
 
 
 
 
ArcMap will bring up the Field Calculator.  If your 
value is a constant, you can simply type the value 
in the box at the bottom. More likely, your new 
value will be based on values in other fields, so you 
will need to use the calculator. You can create an 
expression by double clicking on the field names. 
For example, to calculate the percent of the 
population 65 and up, click on the field name with 
the total 65 and up, click on the “/” button, and 
click on the field name with the total population. If 
any of the records in your table are highlighted, 
ArcMap will only perform calculations on the 
highlighted records. You can also calculate values 
from ArcToolbox (under “Data Management Tools”, 
then “Calculate Field”). 
 
Calculating Values In an Edit Session 

In order to make changes within an “edit session,” 
you need to go the Edit toolbar and, from the edit 
menu, choose “start editing.” You can only edit the 
contents of one directory at a time in an edit 
session, so you need to identify the directory that 
contains the table you wish to edit. While this is the 
more careful way to proceed, it is also more 
tedious. If you do edit a table outside an edit 
session, it’s best to create new fields rather than to 
edit values in an existing field, since you cannot 
undo your work. With new fields, you can just 
delete a field and start over if you mess up. 
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Calculating Values on Selected Records 

You can get an error while calculating values for many 
different reasons.  ArcMap will not allow you to divide by 
zero, so if the denominator (total population in example 
above) is zero for any of your records, ArcMap will not 
calculate any of the values.   

To get around this, you need to select only the records where the denominator is 
something other than zero. Start by selecting the records with a zero in the 
denominator (because there are fewer of these). Do this by right clicking the field 
with your denominator and sorting ascending. Holding down the control key, 
highlight all the records with a zero. From the options menu, choose “Switch 
Selection” so that all of the records with non-zero values are highlighted.  Now you 
should be able to proceed with calculating values. 
 
Editing Individual Values 
You many need to edit an individual value rather than re-calculate values for a 
whole field. To do this, start an edit session by going to “start editing” from the edit 
toolbar. You will need to specify the directory that your table is in before you can 
start editing (you can only edit files within one directory at the same time).   
Open your table and, using the select elements 
tool       click on the value in your table you wish 
to edit.  When you are finished, go to “stop 
editing” in the edit toolbar and say “yes” to 
saving edits. 
 
 
Finding & Replacing Values 
You can find and replace 
values in a table 
systematically from the 
options menu. In order to 
replace values, you must be 
have started an edit session 
(from the edit toolbar, go to 
“start editing”).   
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Calculating Area, Perimeter, and Length 
 
Calculating Area 
Usually there will be a field called “area” in a shapefile when you receive it that 
indicates the area of each polygon map feature. If your shapefile is missing this 
field or if you have edited the shape and size of the map features, you will need to 
calculate area. Area can be especially helpful when you are trying to normalize 
values and create densities (calculating persons per square mile, for example). 
 
To calculate area, you must open the attribute 
table associated with your polygon shapefile 
(right click on the name in the table of 
contents and go to “Open Attribute Table”).  
From the options menu, go to “Add Field.”  
Call your field “area,” choose “double” as the 
style, and click “ok.” Right click on your new 
field and go to “Calculate Values.”  Check 
“Advanced” and type the following in the first 
text box: 

 

Dim dblArea as double 
Dim pArea as IArea 
Set pArea = [shape] 
dblArea = pArea.area 

 

Type “dblArea” in the next box and click “OK”. 
You can copy and paste this script directly from the ArcView help (or from this 
manual). From the ArcView help menu, click on the “search” tab and type “make 
field calculations.” Depending on the version of ArcView you are running, the 
second entry that’s found will include this and other scripts. 
 
Calculating Perimeter 
As with area, you may inherit polygon shapefiles with a perimeter field. If not, or if 
you need to recalculate it, proceed as you would to calculate area.   
 

Open the attribute table, click on “Options” and 
go to “Add Field.” Create a field called 
“Perimeter,” choose “double” for the style, and 
click “OK.”  Right click on the heading of your 
new column and go to “Calculate Values.”  Check 
“Advanced” and type the following into the first 
text box: 
 

Dim dblPerimeter as double 
Dim pCurve as ICurve 
Set pCurve = [shape] 
dblPerimeter = pCurve.Length  

 

Type “dblPerimeter” in the second text box and 
click “OK.” 
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Calculating Length 
You may also need to calculate, or recalculate, the length of the line segments that 
make up a line shapefile (such as streets or railroad tracks).   
Open the attribute table, click on “Options” 
and go to “Add Field.” Create a field called 
“Length,” choose “double” for the style, and 
click “OK.” Right click on the heading of your 
new column and go to “Calculate Values.”  
Check “Advanced” and type the following 
into the first text box: 
 

Dim dblLength as double 
Dim pCurve as Icurve 
Set pCurve = [shape] 
dblLength = pCurve.Length 

 
Type “dblLength” in the second text box and click “OK.” 
 

Changing Units 
ArcMap will calculate area based on the map 
units used for the projection in which the 
shapefile is stored. For unprojected data, this 
is decimal degrees (not particularly helpful for 
understanding area). For projected shapefiles, 
the most common map units are meters and 
feet. If you are not sure what units ArcMap is 
using, check the spatial reference properties.  
From ArcCatalog, right click on the shapefile 
name and go to “Properties.”  With the 
“Fields” tab active, click on the field name 
“Shape” and then click on the “…” next to the 
“Spatial Reference” at the bottom of the Field 
Properties. Look for the unit listed next to 
“Linear Unit.” 

 
Most likely, your data will be in projections using feet or meters as the map unit.  
To convert feet to miles (for perimeter and length), divide the area by 5,280. To 
convert meters to miles, divide by 1,609.344.  To convert square feet to square 
miles, divide the area by (5,280*5,280) = 27,878,400. To convert square meters to 
square miles, divide by (1,609.344 *1,609.344) = 2,589,988.110336. For more on 
conversions, visit http://www.onlineconversion.com/length.htm or 
http://www.translatum.gr/converter/measurements.htm. 
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Creating XY Coordinates 
 
Adding XY Coordinates to a Point Layer 
Just as you may need to convert a table with XY data into a map layer, you may 
need to add XY coordinates to an existing layer containing points. You do this by 
creating new X and Y columns and using a Visual Basic script to calculating the X 
and Y values (coordinates).   
 
With your attribute table open, go to options, 
add new field called “X,” type “Double.”  
Right click at the top of your new column 
and go to “Calculate Values…” Check 
“Advanced” and type the following in the first 
box (that says “Pre-logic VBA Script Code”): 

Dim dblX As Double 
Dim pPoint As IPoint 
Set pPoint = [Shape] 
dblX = pPoint.X 

Then type “dblX” in the smaller text box 
(that says “X =”) in the text box directly 
under the X field name. Click “ok.” Follow 
the same steps to create and calculate a Y 
field, changing the Xs in the VB script to Y.   
 
You can also create XY coordinates for a point file in ArcToolbox (under “Data 
Management Tools” go to “Features” to fine “Add XY Coordinates”). 
 
You can check the new XY coordinates by mapping them.  With you table open, 
click on “Options,” and go to “Export.” Say “yes” and add the new table to your 
existing map, then close the table. From the tools menu, go to “Add XY Data” and 
select your table from the drop down menu (ArcMap will probably have done this 
for you already). Click “ok.” Your table of contents should now show two identical 
point layers. 
 
Adding XY Centroid Coordinates to Polygon Layer 
Adding the X and Y coordinates of the centroids of polygons is similar to adding X 
and Y coordinates to a point layer. With your attribute table open, go to options, 
add new field called “X,” type “Double.” Right click at the top of your new column 
and go to “Calculate Values…” Check “Advanced” and type the following in the first 
box (that says “Pre-logic VBA Script Code”): 

Dim dblX As Double 
Dim pArea As IArea 
Set pArea = [Shape] 
dblX = pArea.Centroid.X 

Then type “dblX” in the smaller text box (that says “X =”) in the text box directly 
under the X field name. Click “ok.” Follow the same steps to create and calculate a 
Y field, changing the Xs in the VB script to Y.   
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You can check the new XY 
coordinates by mapping them.  
With you table open, click on 
“Options,” and go to “Export.”  
Say “yes” and add the new table 
to your existing map, then close 
the table.  From the tools menu, 
go to “Add XY Data” and select 
your table from the drop down 
menu (ArcMap will probably have 
done this for you already). Click 
“ok.” Your table of contents 
should now show a new point 
layer that represents the centroid 
of your polygon layer. 
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Joining Tables 
 
In GIS, you can link map features to their attributes, but only when your attributes 
are in the same file as your geographic data. Often you will have attributes stored 
in a separate table that you will need to join to a shapefile in order to display that 
data. This is especially common with census data, when you will often obtain 
census attribute data (SF1 or SF3) in files separate from the shapefiles for census 
tracts and blockgroups.   
 
Identifying a key 
In order to join an attribute table to a shapefile, you will need to identify a field that 
is common to your attribute table and the attribute table associated with your 
shapefile. This field is known as a key, or unique identifier because it uniquely 
identifies each record in your table and shapefile on which ArcView can join, or 
match, your data. The values must be formatted in an identical way. If they are 
not, you must edit one of the fields or create a new field and recalculate the values 
so that they match perfectly. 
 

At left, the attribute 
table of a census tract 
shapefile contains 
multiple fields that 
uniquely identify each 
record: TRT2000, 
STFID, and TRACTID. 

 
 
 
 
 
The table at right includes 
several attributes of census 
tracts but cannot be mapped 
until it is joined to a shapefile. 
There are two fields that 
uniquely identify records AND 
match fields in the census 
tract shapefile: TRACT and 
STFID. 
The field name doesn’t have to be the same in the attribute table and the shapefile 
in order to join them; they just have to be formatted in the same way. 
 
While you may perform joins on census data most frequently, you can join 
attributes to shapefiles for other data: zipcodes, councilmanic districts, counties. 
You can join on a name (such as neighborhood name, or the name of an 
institution), although keep in mind that differences in spelling and spacing will keep 
records from joining. 
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Joining a table 
To join attribute data to a shapefile, you 
must add the shapefile to ArcMap.  Right 
click on its name in the table of contents, go 
to “Joins and Relates,” and then “Join…” 
Choose “Join attributes from a table” in the 
first dropdown menu. In the second 
dropdown menu, identify the key you’ll use 
in your shapefile.  Next, choose the table 
you wish to join (this does not need to be 
added to ArcMap). Finally, identify the key in 
this table.  Keep in mind that ArcView is not 
checking to make sure that these keys 
match, so you should double-check them (by 
opening both tables) before performing the 
join. 
 

From “Advanced,” you can indicate what you 
want ArcView to do if all of the map features 
in the shapefile don’t have a match in the 
attribute table, or vice versa. The default is 
to keep all records, meaning that some map 
features might have no values for some 
fields. Individual records might not match 
because of problems with the key or because 
there are different numbers of records in 
each of your files. 
 

 
When you open your shapefile, there should be new fields that contain the data 
from your attribute table. The new field names will include the name of the 
attribute table from which it came. The join holding the data together is not 
permanent, so if you add the shapefile to another map document, you will not have 
the appended data. To make the join permanent, right click on the shapefile name, 
go to “Data,” and choose “Export Data…” This works like a “save as,” so it creates a 
new shapefile. Give your new file a name and location. The resulting shapefile will 
have variable names that are much shorter than those in the table created during 
the temporary join. 
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Adding Hyperlinks 
 
Hyperlinks allow you to click on a map 
feature and bring up a relevant image (or 
website) rather than just the attribute values 
stored in your attribute table. Click on the 
map feature you wish to link with the 
identify      tool. Make sure that the “Identify 
Results” table brings up information relating 
to the right map layer.  Right click on the 
text in the box on the left and go to “Add 
Hyperlink.”   
 

From the “Add Hyperlinks” box, click on the 
folder icon and navigate to the image you 
wish to link.  Click “OK” and “OK,” then close 
the “Identify Results” box. You should now 
see a lightning bolt     button in your Tools 
toolbar (previously it would be grayed out).  
Click on the lightning bolt and move the 
cursor over your map.  When the cursor is 
over the map feature with the hyperlink, you 
should see the path name for the image 
appear.  Click on the map feature and your 
image should appear. You can add multiple 
hyperlinks to the same map feature using 
this method. To remove hyperlinks, from the 
“Identify Results” box, right click on the text 
on the right and go to “Manage Hyperlinks.” 

 
If nothing happens when you click on the 
hyperlink, you probably need to set or reset 
the default program for opening the image.  
Find the image file you were trying to link to 
using My Computer or Windows Explorer, 
right click on it, and go to “Properties.”  
Check the program listed next to “Open 
with.” If none is listed, click on “Change” and 
pick a program (an image program or an 
internet browser, for example). Click “OK” 
and “OK.” To make sure the new program 
can open your image file, double click on the 
image file. If the software program opens 
and displays your image, this should also 
work for your hyperlink. 
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Adding Hyperlinks through Attribute Tables 
If you have more than a few hyperlinks for a map layer, it might be easier to add 
them using the attribute table. Create a new text field called “Hyperlinks.”  Start an 
edit session (from the Edit toolbar, go to “Start editing”). Type the full name of the 
image file, including the path (for example, c:/esri/maps/image.tif) in the 
appropriate record. Now you need to make the hyperlink(s) active. In ArcMap, 
double click on your shapefile name in the table of contents and, from the Layer 
Properties dialogue, make the “Display” tab active.  Put a check mark in the 
Hyperlinks box and, from the dropdown menu, choose the field that contains your 
hyperlinks. Now you should be able to bring up the hyperlink using the lightning 
bolt button. 
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Geocoding Addresses 
 
Geocoding refers to the process of transforming street addresses into map features.  
In order to geocode, you need to have a table with addresses and a shapefile for 
streets that matches the geographic extent of your addresses. Through the 
geocoding process, ArcMap will create a new point shapefile by matching each 
street name and number in your table to a place along a line segment in your 
streets shapefile that represents a certain range of house numbers. 
 
Preparing Tabular Data 
In order to geocode, you need a table (.dbf or comma-
delimited .txt) that has a field with street addresses. If 
the parts of the address—house number, street 
direction, street name, and designation/ type—are in 
separate fields, you will need to collapse these into a 
single field.  Having a separate field with the zip code 
can also be helpful. 
 

Creating an Address Locator 
You also need a shapefile that includes information 
about all of the streets in your area. A street 
centerline file is made up of line segments that 
represent certain ranges of house numbers. The 
line segments also contain information about which 
side has even and odd house numbers. In order to 
be able to use the street file for geocoding, you 
need to create an address locator from it. To do 
this, open ArcCatalog, expand the Address Locator 
(click on the +), and double click on “Create New 
Address Locator.” Choose “US Streets (file)” from 
the list and click “OK.”  

 
 
You can also use the US Streets with zone (file). This allows you to include zip code 
along with house number and street. While this is a more careful approach, it will 
generally make it more difficult to obtain a good match rate. 
 
On the next screen, use the folder icon to browse for 
your streets shapefile and click “add.” In the “Fields” 
section below, ArcView may be able to identify the 
appropriate fields on its own. If no field names 
appear in the drop down menus, or if they do not 
look right to you, you’ll need to identify these 
yourself. The “Input Address Fields” section allows 
you to identify the names for the field(s) in your 
tabular data that contain the street address. You 
don’t need to include the field name at this point.  
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The “Matching Options” allow you to indicate the level of sensitivity for the 
matching process. Essentially, ArcView needs to match the house numbers and 
street names in your tabular data with information in the streets shapefile. If the 
spelling of the street name is slightly different or an appropriate range of house 
numbers cannot be located, ArcView will assign the match a less than perfect score 
(100 is a perfect match). 
 
ArcView can geocode based on street intersections in addition to specific house 
numbers.  In the “Intersections” section you can identify symbols (or “AND”) used 
in your tabular data to indicate intersections. The “Side Offset” option allows you to 
place points slightly away from the middle of the street centerline file.  While 
ArcView will know what side of the street your address falls on, your points will 
appear to fall directly on the centerline unless you specify an offset.  15-20 feet is 
adequate. Under “Output Fields,” if you check “X and Y coordinates,” ArcView will 
add X and Y fields to the point shapefile with your addresses. Once you click “OK,” 
a new address locator should be listed under “Address Locators” in the Catalog.  
Once you have created an address locator, you don’t need to do it again (unless 
you go to a new computer). 
 
Geocoding Addresses 
To geocode your addresses, you need to be in 
ArcMap.  You don’t need to have your table with 
addresses OR your street file in your map 
document. From the Tools menu, go to 
“Geocoding” and “Geocoding Addresses.” In the 
“Add Address Locator” screen, click on “Add” and 
navigate to the “Address Locators” at the far right. 
Double click, locate your address locator, click 
“Add,” then click “OK.” On the next screen, you 
need to identify the table with your addresses, the 
field that contains the street address, and a name 
and location for the new point shapefile that will be 
created. The “Geocoding Options” give you access 
to many of the same options available when you 
create an address locator. 
 
When you click “OK,” ArcMap begins the geocoding 
process. The next screen indicates how well ArcView was 
able to match the addresses. You can review different 
subsets of the addresses (unmatched addresses, 
addresses that matched below a certain score…) by 
checking the radio button and clicking “Match 
Interactively.” If you have thousands of addresses in your 
address table, you may not be able to review all of the 
unmatched records. But for smaller data sets it’s very 
important to review the unmatched records. If you didn’t 
choose the “match if tie” option when you set up your 
address locator, the addresses with candidate ties will 
appear with the unmatched addresses. 
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From here, you can change the address in 
order to get a match/better match (don’t 
worry, this only changes the address that 
ArcView uses for geocoding; it does not 
change the data in your original table of 
addresses). To edit an address, simply click 
in the text box “Street or intersection” and 
make the changes, then hit the Enter key.  
ArcView will list possible matches at the 
bottom. Highlight the best candidate and 
click “match.”   
 

Street intersections are the most likely to 
create ties in the matching process.  In the 
example at right, ArcView doesn’t know if it 
should place the 10th and Market point on 
10th Street just north or just south of Market 
Street.  Most likely, it will not matter for 
your work. If it does, you are better off using 
a house number and street, rather than an 
intersection. Choosing the “match if 
candidates tie” box in the geocoding options 
will help you avoid having to match these 
individually. 
 
When you click “done,” a new point shapefile should appear in your table of 
contents.  If you open the attribute table associated with the shapefile, you will see 
that the geocoding process added several fields to your original address table.  The 
“Status” field indicates whether the record was matched (M) or left unmatched (U).  
The “Score” field indicates how closely the record matched the street centerline file.  
The “Side” field indicates on which side of the street the address was matched. The 
“Arc_Street” field is the address used in the match.  This will be the same as the 
original address unless you edited it during the “Interactive Review.” 
 
Rematching Addresses 
You can resume the “Interactive Review” 
even after you’ve clicked “done” and stopped 
geocoding. This allows you to collect 
additional information about unmatched 
addresses. From the tools menu, go to 
Geocoding, Review/Rematch Addresses and 
choose from the recently geocoded files.  
You will need to start an edit session in order 
to proceed.   
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Determining an acceptable match rate 
Aim for a match rate of at least 90 or 95 percent.  Be sure to write down the match 
rate so that you can report it later.  Often you will receive a list of addresses that 
contains some PO Box numbers or missing data that will prevent you from 
matching all your records. Other times your addresses will look fine but simply 
won’t match the street centerline file. The most important thing to determine is if 
the error (the unmatched records) is random or systematic. If you have done all 
that you can to gather complete and accurate addresses, random error is 
acceptable and probably unavoidable. Systematic error is not. Be sure to check for 
patterns in your unmatched records (either by interactively reviewing unmatched 
records or, after finishing geocoding, open the attribute table and sort by “status” 
to review all the “U,” unmatched records). In Philadelphia, look for problems with 
Roosevelt Boulevard and numbered streets (particularly 2nd – 9th Street). There is 
no guarantee that the matched records will be mapped in the right place.  Do a 
spot check with the “Identify” tool to make sure that records mapped somewhere 
that makes sense to you. 
 
Locating an individual address 
If you have only an address or two to map, you can 
take a shortcut. From the File menu, choose “Find” 
and click on the “Address” tab. Next, choose an 
address locator in the drop down menu. If you 
have not already created an address locator, you 
will need to do so.  Next, type in the address in the 
“Street or Intersection” box and click “Find.”  
ArcView will display the possible matches below, 
with their score. Right click on one of the addresses 
for mapping options. You might choose to “Flash 
Candidate Location(s)” to make sure it’s mapping 
in the right area or “Add as Graphic(s)” if you want 
a marker at the location. Keep in mind that this is 
only a graphic; it can easily be deleted or moved.  
You can change the size and color of the graphic, 
but you cannot turn it on and off like map layer, 
and it has no attributes associated with it. 
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Spatial Joins 
 
Tabular joins use a common unique identifier to attach an attribute table to a 
shapefile. Spatial joins use common geography to append fields from one layer, or 
information about a layer, to another layer. This allows you to assign the 
characteristics of an area—such as a census tract or city council district—to 
individual houses, individuals, or events as well as to aggregate points by areas. 
 
Assigning Area Characteristics to Points 
Using a spatial join, you can determine into what area a point falls. For example, 
you might need to determine in what census tract each of your study participants 
lives. You must have a point theme and a polygon theme in ArcMap in order to do 
this.  Right click on the point theme, go to “Joins and Relates…,” and choose “Join.” 
 

In the first dropdown menu, indicate that you want 
to join data to that layer based on spatial location.  
In the next dropdown menu, choose your polygon 
layer. Next, choose the first radio button so that 
each point is given all the attributes of the polygon 
it falls inside. If you have points outside your 
polygon (for example, if you have a census tract 
map of Philadelphia with points representing 
addresses in the city and just outside it), choose 
the second radio button. Specify the name and 
location of the new point shapefile that will be 
created and click “OK.” The resulting point 
shapefile will have as many new columns as your 
polygon shapefile. This may include only the 
polygon identifier (such as the census tract 
number) or the identifier and attributes.   

 
 
 
 
 
 
 
 
 
 
 
Aggregating Points by Polygons 
Using a spatial join, you can also determine how many points fall in each polygon.  
For example, you might need to determine how many mortgages were made in 
each city council district. You must have a point theme and a polygon theme in 
ArcMap in order to do this.  Right click on the polygon theme, go to “Joins and 
Relates…,” and choose “Join.” 
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In the first dropdown menu, indicate that you 
want to join data to that layer based on spatial 
location. In the next dropdown menu, choose 
your point layer. Next, the radio button should 
be set for the second from the top option, “Each 
polygon will be given a summary of the numeric 
attributes of the points that fall inside it, and a 
count field showing how many points fall inside 
it.” If your points do not all fall within your 
polygons (for example, you have a map of city 
council districts and points representing 
addresses in the city and just outside it), choose 
the second radio button, instead. You can then 
decide if you want to summarize the attributes 
of your points by their areas in the boxes below.  
Finally, specify the name and location of the 
new area shapefile that will be created. Click 
“OK.” 
 
If you did not check any of the boxes to summarize the attributes of the points, 
your new shapefile will have only one new field called “count.” This will indicate how 
many points fall into each polygon. You will probably want to change the name to 
something that you will remember (by creating a new field called “MortgageCount,” 
for example, and calculating it as equal to “Count”). Now you can use this count 
value as the basis of a thematic map. 
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Querying by Attribute 
 
In GIS, you can identify a subset of map features based on their attributes or their 
location. You may use queries as an intermediary step, as part of getting to know 
your data, to create new values, or to answer your research questions. 
 
Select by Attribute 
To start a query, from the Selection menu go to 
“Select by Attributes.”  our first choice is what layer 
in your map you wish to query (attribute queries are 
limited to a single layer).  In the Method drop down 
menu, you need to decide whether you are building 
on a previous query or starting fresh.  From here, 
the query dialog is similar to “Calculate Fields.”  
Build an expression using the field names and 
functions, connecting statements with “AND” or “OR” 
as necessary. The values associated with each field 
will be displayed in the text box at the far right. You 
can use these or type in your own.  If you want help 
working through these steps, click on the Query 
Wizard button.  Click “Verify” to make sure ArcMap 
likes your expression. You can import (Load) and 
save expressions using the buttons OR using Ctrl + C 
and Ctrl + V with a word processing file. 
Note that if the values you input are text, rather than numbers, you need to put 
single quotes around them (for example, ‘BROAD’). 
 
When you click “Apply,” the map features that satisfy your query will be highlighted 
with a bright blue outline. You can perform an additional query (adding, removing, 
or selecting from this selected group) or close the query dialog. To review the 
selected records, right click on the map layer and go to “Open Attribute Table.”  
Click on the Select button at the bottom to view only the selected records. You can 
calculate values on an existing or new field for only the selected records (for 
example, calculating the percent of multiracial people only in block groups with 
non-zero populations). You can also generate summary statistics for only the 
selected records by right clicking on a column name and going to “Statistics.” To 
see all of the selected records at the closest extent, from the Selection menu, go to 
“Zoom to Selected Records.”    
 

You can create a new shapefile that only includes your 
selected map features by right clicking on its name in 
the Table of Contents, going to “Data” and “Export 
Data.” Choose the radio button regarding coordinate 
systems (you’ll probably want the default). Make sure 
you have “Selected Records” chosen in the Export drop 
down menu. To un-select all records, from the Selection 
menu choose “Clear Selected Features.” 
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Querying by Location 
 
The ability to query based on the location of map features is something unique to 
GIS, and combining attribute and location queries really takes advantage of GIS 
functionality.  
 
Select by Location 
To select features in a map layer based on their 
location, from the Selection menu go to “Select by 
Location.” Your first choice involves the nature of 
the selection. Are you starting from scratch or 
querying a subset of map features already 
selected?  In the next box, put a check mark next 
to the map layer(s) whose features you wish to 
select. The drop down menu then provides various 
relationships between the features in that layer and 
a subsequent layer (identified in the next drop 
down menu). For distance-based queries, you will 
be able to select your units as long as the map 
units have been specified in the Data Frame 
properties. The images at the bottom of the dialog 
change as you choose a different type of 
relationship as the basis of your location query 
(they may or may not be helpful). 
 
Combining Attribute and Location Queries  
The “Select by Attribute” and “Select by Location” dialogs do not allow you to mix 
the type of query. But by performing one type of query first and then conducting a 
subsequent query on the selected records, you can perform attribute and location 
queries on the same map layer. For example, you may be interested in what census 
tracts are located along a river, but you are only interested in census tracts that 
have at least 100 people living in them. It doesn’t matter which query you do first.  
Just be sure that the selection method you choose for the second query allows you 
to add, remove, or select from the records selected from the first query. 
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Measuring Distances 
 
 

Using the Measure Tool 
The measure tool allows you to draw a line, 
or a series of connected lines, to roughly 
measure the Euclidean (as the crow flies) 
distance between points. The measure tool 
will use the display units you specified in the 
Data Frame Properties (right click on the 
name of the Data Frame, go to Properties, 
and the General tab). Click on it and then 
click on your map at the starting point.  
Move your cursor to your end point, or next 
point, repeating until you are done.  Double 
click to finish.   
ArcMap will display the cumulative distance in the bottom left part of the GUI 
(below the table of contents). Once you move your cursor outside of the map 
window, your results will disappear. Try following a street centerline layer if you 
want to generate more realistic travel distances.  
 
Measuring with Attribute Data 
If you need more accurate measures of distance than you can get using the 
measure tool, you can use the values in perimeter (polygons) and length (line) 
fields of the shapefile attribute tables.  Select the features of interest, then right 
click on the perimeter or length field and go to “Summary.” The “sum” field will 
indicate the total distance. For example, if you need to know the total length of 
Broad and Market Streets, go to “Select by Attributes” and select all line segments 
in the street centerline file called “BROAD” or “MARKET.” Then open the attribute 
table associated with the street centerline file, right click on the “length” column 
heading, and go to “Summary.” The “sum” should indicate how long Broad and 
Market Streets are.   
 
 
 
 
 
 
 
 
 
 
 
 
Measuring Distance with Networks 
Euclidean is just one method of measuring distance, and a rather crude one at that.  
Using ArcView’s Network Analyst, it is possible to factor in travel times and traffic 
patterns, among other considerations. 
 



Cartographic Modeling Laboratory                                                                                          ArcView 9 Manual 
 

 64

Creating Buffers 
 
Buffers allow you to create temporary graphics or 
permanent shapefiles around existing map 
features. You can create buffers around any type of 
vector data (points, line, or polyons) and around 
selected or all features in a map layer. The Buffer 
Wizard is a custom tool that must be added to the 
ArcMap interface. From the tools menu, go to 
“customize” and click on the “commands” tab. 
From the “categories” list, click on “tools.” You can  
then drag the Buffer Wizard to one of your active toolbars. From the drop down 
menu, choose the map layer you wish to buffer. If some of your layers are selected, 
you can choose to buffer only the highlighted features. 
 

On the next screen, you choose how you want to 
create buffers. You can make buffers based on a 
certain distance or based on an attribute in your map 
layer (this would allow you to have larger and smaller 
buffers around different features). If necessary, 
change the distance units at the bottom of the screen.  
You can make multiple rings of a certain distance. 

 
On the final screen, you must decide what to do if the buffers overlap: dissolve the 
intersecting lines or leave them?  If the map layer you are buffering contains 
polygons, you can specify whether buffers should be drawn inside, outside, or both. 

Finally, specify how ArcMap should save the 
layer. If you save it as a graphic, it will be 
temporary. This is helpful if you are just 
playing to get the right buffer since it can 
easily be deleted. Saving the buffers as a 
separate shapefile is more permanent and 
deleting a shapefile involves more work. To 
save the buffer as part of an existing layer, 
you must start an edit session and make that 
layer edit-able.   

 
Buffering can take ArcView a long time, 
especially if you choose to dissolve the 
barriers within the buffers.  However, if 
you do not dissolve the barriers, your 
buffers may involve lots of separate 
polygons. If you saved the buffers as a 
shapefile, there will be an attribute table 
with records corresponding to the 
separate polygons making up the buffer. 
If you choose to dissolve the barriers, 
there will be just one record (and just 
one polygon). 
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Editing Shapefiles 
 
Editing shapefiles is tricky—and a bit dangerous—territory. If possible, use the 
geoprocessing tools to make changes to your shapefiles rather than using the 
editing tools described below. Keep in mind also that editing shapefiles can change 
attribute values (such as area and perimeter) that you may need to update. 
 
Deleting and Modifying Features 
In order to make changes to a shapefile, you 
must start an edit session. From the Editor 
toolbar, choose “start editing.” If you have 
multiple shapefiles in your map document that 
are from different subdirectories on your 
computer, you will need to specify which directory 
will be part of the edit session (you can only edit 
the files in a single folder at one time). From the 
Target drop down menu in the Editor toolbar, 
indicate which map layer you wish to edit. 
 

To edit an existing feature (point, line, or 
polygon), click on the edit tool      and 
click on the feature you wish to edit (it 
should become highlighted).  By clicking 
and holding down the mouse button, you 
can move your map feature to a new 
location. To modify a line or polygon 
feature, double click on it. Notice that the 
vertices become visible and the Task 
menu automatically brings up “Modify a 
Feature.”  You can reshape your feature 
by putting your cursor over a vertex, 
clicking, and dragging it. Click outside of 
the map feature to complete.  (ArcView 
will show the last created vertex in red).  
You can add a vertex to a feature by right 
clicking on a green line and going to 
“insert vertex” (a new vertex will be 
created where you right click). 

 
Most of the boundaries between polygons are shared 
boundaries.  In order to move the boundary for both 
polygons (rather than creating an awkward gap), 
you need to use the shared edit       tool.  Click on 
the shared edit tool and double click anywhere on 
the shared boundary. The shared boundary will be 
shown in green and the vertices along the shared 
boundary will become visible. Move a vertex, then 
click outside the map feature to complete. 
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To save edits, from the Editor menu on the Editor toolbar, choose “Stop Editing” 
and say “yes” to saving edits. Notice that you do not have a “save as” option.  You 
may want to make a backup of your original data before editing. 
 

Merging Features 
In order to dissolve the boundaries between two or 
more polygon features, you must start an edit 
session.  Using the edit tool and the shift key, click 
on the features you wish to merge (they should 
become highlighted), then from the Editor menu on 
the Editor toolbar select “Merge.” You can also 
select map features based on their attributes by 
opening the attribute table and selecting the 
corresponding records. To save edits, from the 
Editor menu on the Editor toolbar, choose “Stop 
Editing” and say “yes” to saving edits. 

 
Splitting Features  
Splitting polygon features involves creating a new 
line within an existing polygon. Start an edit 
session and choose “Cut Polygon Features” from 
the Task drop down menu. Using the edit tool, 
select the polygon you wish to split. Click on the 
sketch tool and then draw a line through your 
polygon (the line does NOT have to be straight), 
double clicking to complete. To save edits, from 
the Editor menu on the Editor toolbar, choose 
“Stop Editing” and say “yes” to saving edits. 
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Transforming Shapefiles 
 
There are a number of different functions you can perform on map layers, either 
based on location or attribute value that result in new map layers. Several of them 
fall under the description of “overlay analysis.” In ArcView 8, these were called 
“geoprocessing” function. In ArcView 9, they have been incorporated into an 
expanded suite of data management tools. You must define the projection for map 
layers before using any of these functions. If you have selected a subset of features 
within a map layer, the functions will only be performed on the selected features. 

 
Dissolve 
The dissolve operation allows you to 
collapse the boundaries between 
polygons if they share the same value on 
a particular attribute.  For example, you 
could create a neighborhood map layer 
by assigning each blockgroup to a 
neighborhood and then dissolving the 
boundaries. From ArcToolbox, you can 
find “Dissolve” under “Data Management 
Tools” and “Generalization.” 

 
On the next screen, you need to identify the map layer whose features you wish to 
dissolve under “input features.” If the layer is already added to ArcMap, you can 
use the dropdown menu. Otherwise you will need to click on the folder icon to 
locate the may layer. ArcMap will give the new shapefile that will be created a 
default name (adding “_Dissolve” to the input layer name). If you want to rename 
this or change the location, click on the folder to the right of “input feature class.” 
Next, choose the column in from that layer’s attribute table that contains the 
information you wish to use for the dissolve. This must be an attribute for which 
multiple map features (polygons) have the exact same value. The values can be 
numbers or text, although keep in mind that nominal and categorical variables will 
work better than ratio variables. If polygons have the same value but are not 
contiguous, they will still be dissolved into a “multipart feature.” 
 
Append 
Appending (referred to as “merging” in 
ArcView 8) allows you to incorporate two or 
more non-overlapping layers into a single map 
layer without changing their map features. 
You can append point, line, and polygon 
layers. Appending can save you time when it 
comes to symbolizing features and lead to 
more consistent symbology. For example, you 
can merge census tract files from several 
counties so that when you display the percent 
of homeowners, you don’t have to repeat the 
process of classifying your data for each 
county. 
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From ArcToolbox, you can find “Append” under “Data Management Tools” and 
“General.” Under “input features,” list all the map layers you wish to merge. You 
can use the dropdown menu if you have added the map layers to ArcMap, but you 
will need to add them one at a time. A new layer will not automatically be created, 
so you will need to specific and EXISTING  layer in “output feature.” This will 
overwrite the existing layer, so be sure to make a backup copy if necessary. If the 
columns in the attribute tables of all the input features are identical, you can select 
“TEST” under “Scheme Type.” Otherwise, you must choose “NO_TEST.” 
 
 
The resulting shapefile will contain all of 
the map features in the appended layers.  
If the column names were the same for all 
of the layers (as they could be for census 
tract files from different counties), there 
will be values for each record in each 
column.  Keep in mind that these merged 
shapefiles can grow very large, particularly 
if you merge street centerline files. 
 
 

Clip 
Clipping allows you to turn one shapefile 
into a cookie-cutter in order to cut out 
part of a larger shapefile. For example, 
you might need to create a map layer of 
streets for the area within a single police 
district but your street centerline file 
covers the entire city. Using a street file 
that is clipped by the police district 
boundaries will allow you to work with a 
smaller and more manageable file that 
looks neater. From ArcToolbox, you can 
find “clip” under “Analysis Tools” and 
“Extract.”  

 
On the next screen, you need to identify an input feature (the layer to be clipped) 
and the clip features (cookie cutter). The default name for the new shapefile will be 
the input feature name plus “_Dissolve.” If you want to change this or the location 
of the new file, click on the folder to the right. You can leave “Cluster Tolerance’ at 
0. Changing it will allow slightly mismatched map layers to be considered 
“coincident.”  
 
 
 
 
 
 



Cartographic Modeling Laboratory                                                                                          ArcView 9 Manual 
 

 69

Intersect  
Intersect allows you to fuse two overlapping layers together to create a new 
shapefile that includes the attributes of both layers for the area in which the layers 
overlap. In effect, this combines the union (described below) and clip operations.  
You can intersect two polygon layers or a line and polygon layer. From ArcToolbox, 
you can find the “Intersect” function under “Analysis Tools” and “Overlay.” 
On the next screen, select the input features. The default name for the new 
shapefile will be the first input feature name plus “_Intersect.” If you want to 
change this or the location of the new file, click on the folder to the right. If you 
intersect a line and polygon layers, the resulting shapefile will contain “polylines” 
that act like lines. If you intersect polygon layers, the resulting shapefile will 
contain polygons.   
 
Length, perimeter, and area values will be 
inaccurate after you perform an intersection, 
so if you need these be sure to recalculate 
them. Other attribute values maybe deceptive, 
as well. In the example at right, census tracts 
were intersected with police districts. The 
result was many sliver polygons resulting from 
slight differences in their digital boundaries, 
not real differences in their actual boundaries.  
Note that three polygons have been given the 
same total population based on the census 
tract data, two of which are sliver polygons. 
Adjusting the cluster tolerance can help you 
avoid sliver polygons. 
 
Union 
Union is similar to intersection in that it fuses 
the boundaries of two layers together, but 
rather than clipping the resulting shapefile to 
include only the area covered by both, it creates 
a new shapefile that covers the combined extent 
of the layers. From ArcToolbox, you can find the 
“Union” function under “Analysis Tools” and 
“Overlay.” Select the input features. The default 
name for the new shapefile will be the first input 
feature name plus “_Union.” If you want to 
change this or the location of the new file, click 
on the folder to the right. 
As with shapefiles created through intersections, the shapefiles created by a union 
will most likely have some attribute values that no longer make sense. Be sure to 
recalculate length, perimeter, and area if you need these variables. 
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Creating Shapefiles 
 
Most of the time you will use shapefiles that someone else created.  Using existing 
shapefiles saves time and generally results in more accurate map layers. But if you 
need a line or polygon file that doesn’t exist—such as a boundary for your study 
area—you will need to create it yourself. Digitizing is the process of drawing or 
tracing map features to create a new geographic file.This process used to involve 
tracing a paper map on a digitizing tablet and then assigning real world coordinates 
to certain parts (like georectifying).  ArcView 8.x has some great on-screen 
digitizing tools that allow you to create new shapefiles without additional hardware 
or software. 
 
Creating New Shapefiles 
Open ArcCatalog to create a new shapefile. Right click on 
the folder where you want to store the new shapefile, go 
to new, and choose “shapefile.” In the dialog box, give 
your new shapefile a name and indicate what type of 
features the shapefile will have: point, line, or polygon.  
Use the Edit button to set the projection. This shapefile is 
essentially just a shell since it contains no information.  
But you need this before you can start to create new map 
features. 
 
 

Next, open ArcMap and add your new shapefile, along with 
other map layers that may help you draw your new features.  
Start an edit session: from the Editor menu in the Editor 
toolbar, choose “Start Edit Session,” and indicate which 
directory contains the shapefile (shell) you just created.  Be 
sure that your new shapefile is listed as the Target and that 
“Create New Features” is selected from the Task menu. 
 

 
Next, you need to choose a drawing tool.  You have five choices: 
 

The Create New Feature tool allows you to draw points, lines, or polygons.   
 
The Arc tool allows you to create lines that are curved (rather than just a 
bunch of short line segments that look like a curve).   
 
The Distance-Distance tool will place a point at one of the locations where 
two circles intersect.   
 
The Intersection tool places a point where two lines would cross if they 
continued far enough.   
 
The Trace tool creates features that follow existing map features. 
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The Create New Features tool is the 
most basic and allows you to draw 
new map features.  Click to create a 
new vertex and double click to finish.  
In the example at left, a new 
polygon feature was drawn that 
follows four streets.  Use the delete 
tool to start over.  Use the undo tool 
to remove the last vertex.  To save 
your new feature, from the Editor 
menu choose “Stop Editing” and 
save edits. 

 
Snapping to an Existing Feature 
It is nearly impossible to draw features 
that match an existing layer just by 
looking at it. Zooming in to the polygon 
shapefile created above shows that 
there are gaps between the new 
shapefile and the street centerline that 
was used as a guide. This looks sloppy 
and can impact the result of your 
analyses.  
 

You can avoid this problem by “snapping” your new 
lines to an existing shapefile. From the Editor menu 
of the Editor toolbar, go to Start Editing and 
indicate which directory contains the shapefile 
(shell) to which you want to add map features.  
From the Editor menu, choose “Snapping.” In the 
top of the dialog box, you can identify the layer(s) 
to which you want to snap your new features. Try 
drawing your new features using different 
combinations of layers and vertices and/or edges.  
If you use a street centerline file as your guide, 
vertices will work well.  
 

Now when you start to draw your new features using 
the Create New Features tool, your cursor will be pulled 
toward the vertices of the shapefile you are trying to 
trace.  To create the most accurate line, move your 
cursor slowly over the existing shapefile, clicking at 
each vertex to create a new vertex in your shapefile.  
You can change the snapping “tolerance”—the distance 
from the existing shapefile you can be and still snap to 
it—from the Editor menu, “Options,” and the “Genera” 
tab.  The map units reflect the units you identified in the 
Data Frame properties (General tab).   
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Using the snapping tool, you 
should be able to create new 
features that line up with existing 
shapefiles, even when you zoom in 
close. If you are not happy with 
your results, click on the map 
feature with the Edit tool and hit 
Delete (you can do this even after 
saving edits to the shapefile, as 
long as you start an Edit Session). 

 
Digitizing using the Merge Tool 
The tools in ArcMap for dissolving boundaries between features provide another 
approach to digitizing. This may give you less control over the shape of new map 
features, but it provides an easier way of creating new shapefiles that line up with 
existing shapefiles. In order to create shapefiles using the dissolve tools, you need 
to have a shapefile that can serve as building blocks for your new file. For example, 
you may want to create a map of health districts. If the districts are based on 
census tracts, you can use a shapefile of census tracts to build your new district 
file. A census block file may prove the most helpful. Census blocks are bounded by 
streets, so any new polygon feature with streets as borders can be created by 
dissolving the boundaries between census blocks. 
 
To start, add a street centerline layer and census block layer to ArcMap. To avoid 
making permanent changes to your census block file, create a new copy of it (right 
click on it, go to “Data” and “Export Data”) and add it to your map. With the streets 
and (new) block layers drawn, zoom into the area where you wish to create new 
features. Use the label tool to identify street names (that’s why you need the street 
file; census block files don’t contain street names). Using the Select Features tool, 
highlight the blocks that cover the area of your new feature. You can select multiple 
features by holding down the shift key. You can also draw a box around the area 
containing the individual features (this is faster). 
 
To dissolve the boundaries between the blocks, 
start an edit session, then from the Editor menu 
choose “merge.” Stop editing and save edits to 
finish. If your new shapefile only needs to include 
this single map feature, you can right click on the 
block shapefile (with the new feature still selected), 
go to Data and Export Data. Be sure that the 
Export drop down menu indicates that only 
selected features will be included. Alternatively, 
you may need to repeat the process of dissolving 
boundaries so that all census blocks become part of 
a new map feature.   
 
 
 




